Copyrights and trademarks
© Copyright 2005 Hewlett-Packard Development Company, L.P.
The information contained herein is subject to change without notice.
Reproduction, adaptation or translation without prior written permission is prohibited, except as allowed under the copyright laws.

Notice
The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.
The Hewlett-Packard Development Company, L.P., shall not be liable for incidental or consequential damages in connection with, or arising out of the furnishing, performance, or use of this document and the program material which it describes.

Trademarks
HP, the HP logo, and Photosmart are property of Hewlett-Packard Development Company, L.P.
The Secure Digital logo is a trademark of the SD Association.
Microsoft and Windows are registered trademarks of Microsoft Corporation.
CompactFlash, CF, and the CF logo are trademarks of the CompactFlash Association (CFA).
Memory Stick, Memory Stick Duo, Memory Stick PRO, and Memory Stick PRO Duo are trademarks or registered trademarks of Sony Corporation.
MultiMediaCard is a trademark of Infineon Technologies AG of Germany, and is licensed to the MMCA (MultiMediaCard Association).
Microdrive is a trademark of Hitachi Global Storage Technologies.
xD-Picture Card is a trademark of Fuji Photo Film Co., Ltd., Toshiba Corporation, and Olympus Optical Co., Ltd.
Mac, the Mac logo, and Macintosh are registered trademarks of Apple Computer, Inc.
The Bluetooth word mark and logos are owned by the Bluetooth SIG, Inc.

and any use of such marks by Hewlett-Packard Company is under license.
PictBridge and the PictBridge logo are trademarks of the Camera & Imaging Products Association (CIPA).
Other brands and their products are trademarks or registered trademarks of their respective holders.
The embedded software in the printer is based in part on the work of the Independent JPEG Group.
The copyrights to certain photos within this document are retained by the original owners.

Regulatory model identification number VCVRA-0402
For regulatory identification purposes, the product is assigned a Regulatory Model Number. The Regulatory Model Number for the product is VCVRA-0402. This regulatory number should not be confused with the marketing name (HP Photosmart 8700 series printer) or product number (Q5745A).

Safety information
Always follow basic safety precautions when using this product to reduce risk of injury from fire or electric shock.

Warning To prevent fire or shock hazard, do not expose this product to rain or any type of moisture.

- Read and understand all instructions in the setup instructions that came in the box with the printer.
- Use only a grounded electrical outlet when connecting the unit to a power source. If you do not know whether the outlet is grounded, check with a qualified electrician.
- Observe all warnings and instructions marked on the product.
- Unplug this product from wall outlets before cleaning.
- Do not install or use this product near water or when you are wet.
- Install the product securely on a stable surface.
- Install the product in a protected location where no one can step on or trip over the power cord, and where the power cord will not be damaged.
- If the product does not operate normally, see the troubleshooting information in the onscreen HP Photosmart Printer Help.
- There are no operator serviceable parts inside. Refer servicing to qualified service personnel.
- Use in a well-ventilated area.

Environmental statements
Hewlett-Packard Company is committed to providing quality products in an environmentally sound manner.

Protecting the environment
This printer has been designed with several attributes to minimize impact on our environment. For more information, go to HP’s Commitment to the Environment web site at www.hp.com/hpinfo/globalcitizenship/environment/.

Ozone production
This product generates no appreciable ozone gas (O₃).

Paper use
This product is suited for the use of recycled paper according to DIN 19309.

Plastics
Plastic parts over 24 grams (0.88 ounces) are marked according to international standards that enhance the ability to identify plastics for recycling purposes at the end of the printer life.

Material safety data sheets
Material Safety Data Sheets (MSDS) can be obtained from the HP web site at www.hp.com/go/msds. Customers without Internet access should contact HP Customer Care.

Recycling program
HP offers an increasing number of product return and recycling programs in many countries, and partners with some of the largest electronics recycling centers throughout the world. HP conserves resources by

Material Safety Data Sheets (MSDS) can be obtained from the HP web site at www.hp.com/go/msds. Customers without Internet access should contact HP Customer Care.

Recycling program
HP offers an increasing number of product return and recycling programs in many countries, and partners with some of the largest electronics recycling centers throughout the world. HP conserves resources by
reselling some of its most popular products.

This HP product contains lead in the solder, which may require special handling at the end of its life.

**Important recycling information for our customers in the European Union**: To preserve the environment, this product must be recycled after its useful life as required by law. The symbol below indicates that this product may not be disposed in the general trash. Please return the product for proper recovery/disposal to the authorized collection location nearest to you. For more information regarding return and recycling of HP products generally, please visit: www.hp.com/hpinfo/globalcitizenship/environment/recycle/index.html.
## Contents

1 **Welcome**................................................................................................................3  
   Finding more information..................................................................................4  
   Printer parts.......................................................................................................4  
   Printer menu.......................................................................................................7  

2 **Getting ready to print**...........................................................................................9  
   Loading paper......................................................................................................9  
   Choosing the right paper....................................................................................9  
   Using specialty papers.......................................................................................10  
   Loading your paper...........................................................................................11  
   Inserting print cartridges...................................................................................13  

3 **Basic printing from a computer**........................................................................17  

4 **Using color management**..................................................................................19  
   Using printer-based color management...............................................................19  
   Using application-based color management......................................................22  

5 **Exploring creative projects**..............................................................................25  
   The large-format templates...............................................................................25  
   The HP Image Zone............................................................................................26  
   Printing borderless photos from a computer....................................................27  

6 **Printing photos without a computer**...............................................................29  
   Connecting to other devices.............................................................................29  
   Printing photos from a memory card................................................................30  
   Inserting memory cards....................................................................................30  
   Supported file formats......................................................................................30  
   Inserting a memory card...................................................................................31  
   Saving photos to a computer from a memory card.........................................32  
   Removing a memory card................................................................................33  
   Deciding which photos to print..........................................................................33  
   Selecting a photo layout....................................................................................33  
   Selecting photos to print..................................................................................36  
   Improving photo quality...................................................................................37  
   Doing common printing tasks from a memory card......................................37  
   Printing photos from a digital camera.............................................................39  
   Using a PictBridge camera..............................................................................39  
   Using a Bluetooth camera...............................................................................39  
   Printing from other Bluetooth devices............................................................40  

7 **Care and maintenance**.......................................................................................41  
   Cleaning and maintaining the printer...............................................................41  
   Cleaning the outside of the printer....................................................................41  
   Automatically cleaning the print cartridges....................................................41  
   Manually cleaning the print cartridge contacts..............................................42  
   Printing a test page...........................................................................................42  
   Aligning the print cartridges..........................................................................43  
   Printing a sample page....................................................................................43  
   Updating the software.......................................................................................43  
   Storing the printer.............................................................................................44
Welcome

Thank you for purchasing an HP Photosmart 8700 series printer! With this new photo printer, you can print professional color and black-and-white photos to sell or display for generations.

This guide primarily provides details about specific printing tasks, including when printing from a computer. For more information about connecting the printer to a computer or printing from a computer, install the printer software and view the onscreen HP Photosmart Printer Help. For information about installing the software, see the setup instructions that came in the box with the printer.

The HP Photosmart 8700 series has features that appeal to serious professional and advanced amateur photographers as well as to creative home users:

<table>
<thead>
<tr>
<th>Professional and advanced amateur photographers (Digital photography, fine arts)</th>
<th>Creative home users (Scrapbooking, arts and crafts, creative projects)</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Turn the color management features of the printer on or off</td>
<td>● Print borderless photos from the printer's control panel or from a computer</td>
</tr>
<tr>
<td>● Use color management to ensure that what you see on the computer screen matches the photos printed on the HP Photosmart</td>
<td>● Use the HP Image Zone software for creative projects</td>
</tr>
<tr>
<td>● Use the color management features in concert with professional software such as Adobe® Photoshop® to produce high-quality, professional prints</td>
<td>● Use special large-format templates for use in scrapbooking</td>
</tr>
</tbody>
</table>

For more information, see Using color management.

The printer comes with the following documentation:

- **Quick Start booklet** or **Setup Guide**: The HP Photosmart 8700 series printer comes with setup instructions that explain how to set up the printer and install the printer software. Which document you receive with the printer varies by country/region.
- **User’s Guide**: The *HP Photosmart 8700 series User’s Guide* is the book you are reading. This book describes the basic features of the printer, explains how to use the printer without connecting a computer, and contains troubleshooting information.
- **HP Photosmart Printer Help**: The onscreen HP Photosmart Printer Help describes how to use the printer with a computer and contains software troubleshooting information.
Finding more information

After you have installed the HP Photosmart printer software on a computer, you can view the onscreen HP Photosmart Printer Help:

- **Windows PC**: From the Start menu, select Programs (in Windows XP, select All Programs) > HP > Photosmart 320, 370, 7400, 8100, 8400, 8700 series > Photosmart Help.
- **Macintosh**: Select Help > Mac Help in the Finder, then select Library > HP Photosmart Printer Help.

Printer parts

![Printer parts diagram]

**Front of printer**

1. **Out tray**: Lift to access the Main tray.
2. **Main tray**: Place photo paper, plain paper, transparencies, envelopes, or other media in this tray for printing.
3. **Top cover**: Lift this cover to access the print cartridges and the print cartridge storage area, and to clear paper jams.
4. **Control panel access door**: Push down and release to access the printer control panel and screen. The panel pops up.
5. **Cancel**: Press this button to deselect photos, to exit a menu, or to stop an action you have requested. There is also a Cancel button on the printer control panel.
6. **On**: Press this button to turn on the printer or put it into power save mode.
7. **Camera port**: Use this port to connect a PictBridge™ digital camera to the printer, or to insert the optional HP Bluetooth® wireless printer adapter.
8. **Memory card slots**: Insert memory cards here.
Back of printer

1. **Ethernet port**: Use this port to connect the printer to a network.
2. **USB port**: Use this port to connect the printer to a computer.
3. **Power cord connection**: Use this port to connect the power cord included with the printer.
4. **Rear access door**: Remove this door to clear paper jams.
5. **Rear feed slot**: Use this slot for supported stiff stock media. Printing through this slot is possible only from the computer. The rear feed slot does not support photo board or banner printing. Be sure to load paper straight into the slot and guide it in so the paper does not skew. For more information, see Loading your paper.
6. **Rear feed slot paper-width guide**: Adjust this guide to fit close to the edge of the paper in the rear paper slot.

Paper trays

1. **Out tray**: Lift to access the Main tray.
2. **Front feed slot**: Place paper here when you want to bypass the Main tray for a single print job. For photo media, have the emulsion (glossy) side down. Ideal for envelopes.
3. **Front feed slot paper-width guide**: Adjust this guide to fit close to the edge of the paper in the front feed slot.
4. **Out tray extender**: Pull it towards you to extend the Out tray to catch the printed paper as it is ejected from the printer.
5. **Main tray**: Place photo paper, plain paper, transparencies, envelopes, or other media in this tray for printing. For photo media, have the emulsion (glossy) side down.
6. **Paper-length guide**: Extend and adjust this guide to fit close to the end of small media in the Main tray.
7. **Main tray release**: Press and pull toward you to release and extend the Main tray. This lets you load large media that could not normally fit in the tray.
8. **Main tray paper-width guide**: Adjust this guide to fit close to the edge of the paper in the Main tray. This helps prevent paper skew.
Control panel

1. **Index page**: Press to print an index page (contact sheet) of photos on a memory card.
2. **Layout**: Press to select the print layout for your photos.
3. **Menu**: Press to view the printer menu.
4. **Navigation arrows**: Press to navigate through menu options or photo numbers.
5. **Print**: Press to select a photo number or menu option.
6. **Print**: Press to print selected photos from the inserted memory card.
7. **Cancel**: Press to deselect photos, to exit a menu, or to stop an action you have requested. There is also a **Cancel** button on the front left of the printer to the right of the **On** button.
8. **Printer screen**: Use this screen to view menus, page layout, ink status, and messages.

Printer screen

1. **Messaging area**: Displays printer messages and menus.
2. **Animations**: Displays printer activity animations.
3. **Ink level**: Displays the current ink level for each cartridge in the printer.
4. **Selected photos**: Displays the index numbers of photos selected from the printer control panel for printing.
5. **Layout/print job status**: Displays the current photo layout, number of pages to print, and layout slots being used.
Indicator lights

1. On light: Solid blue if the printer is on, otherwise off.

2. Memory card light: Solid green if a memory card is correctly inserted, flashing green if the printer is accessing a memory card, flashing red to indicate memory card errors, and off if no memory card is inserted or more than one card is inserted.

3. Status light: Flashing green if the printer is busy (non-printing activity), flashing red if there is an error or if some user action is required, solid amber if an nonrecoverable error has occurred.

4. Print light: Solid blue if the printer is ready to print, pulsing blue if the printer is busy printing.

Printer menu

Press Menu to access the printer menu.

To navigate the printer menu:

- Press ‹ or › to scroll through the menus or options displayed on the printer screen.
- Any menu with a triangle next to it has submenus or options. Press ‡ to display the submenus or options.
- Press Cancel to exit the current menu.

The print menu structure

- Print all: Select to print all the photos on the memory card inserted in the printer.
- Date/time stamp option
  - Date/time
  - Date only
  - Off (default)
● **SmartFocus**: Turn on to focus images for clearer, sharper detail.
  – **On**
  – **Off** (default)

● **Digital Flash**: Turn on to improve photos with poor lighting and contrast.
  – **On**
  – **Off** (default)

● **Change the print quality**
  – **Normal**
  – **Best** (default)

  *Normal* uses less ink than *Best*, and applies only to the current print job. The setting then automatically resets to *Best*.

● **Print a sample page**: Select to print a sample page useful for checking the print quality of the printer.

● **Print a test page**: Select to print a test page containing information about the printer that can help in troubleshooting problems.

● **Network settings**
  – **Display network IP address**: Select to display the IP address of the printer.
  – **Print network settings page**: Select to print a network configuration page that you can use for troubleshooting network connections or for the initial network setup.
  – **Reset network settings**: Select to reset the network settings to the factory defaults.
  – **Reset Bluetooth settings**: Select to reset the Bluetooth settings to the factory defaults.

● **Clean the print cartridges**: Select to clean the print cartridges. After the cleaning finishes, the printer prints a test page. You have the option to clean the cartridges again if the test page shows that they are still not clean.

● **Calibrate the printer**: Select to calibrate the printer.

● **Select paper settings**
  – **Auto-detect** (default): Lets the printer auto-detect paper type and width.
  – **Manually set**: Lets the user manually select paper type and width.

● **Select language**: Select to indicate the language you want used on the printer display.

● **Reset all menu settings**: Restores factory settings for all menu items except **Select language**.
## 2 Getting ready to print

This section includes information on the following:
- Loading paper
- Inserting print cartridges

### Loading paper

Learn how to choose the right paper for your print job and how to load it into the correct tray for printing.

### Choosing the right paper

For a list of available HP inkjet paper, or to purchase supplies, go to:
- [www.hpshopping.com](http://www.hpshopping.com) (U.S.)
- [www.hp.com/go/supplies](http://www.hp.com/go/supplies) (Europe)
- [www.hp.com/jp/supply_inkjet](http://www.hp.com/jp/supply_inkjet) (Japan)
- [www.hp.com/paper](http://www.hp.com/paper) (Asia/Pacific)

To get the best and longest-lasting results from the printer, choose from these high-quality HP photo papers.

<table>
<thead>
<tr>
<th>To print</th>
<th>Use this paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>High-quality, long-lasting prints and enlargements</td>
<td>HP Premium Plus photo paper</td>
</tr>
<tr>
<td>Medium to high resolution images— instant-dry, water resistant casual and business photos</td>
<td>HP Premium photo paper</td>
</tr>
<tr>
<td>Casual photos from e-mail and the web</td>
<td>HP Advanced Photo paper HP Photo paper HP Everyday photo paper</td>
</tr>
<tr>
<td>Text documents, draft versions, test and alignment pages</td>
<td>HP Premium inkjet paper</td>
</tr>
</tbody>
</table>
Note  HP designs its photo papers to resist fading so your photos remain vibrant for years to come. For more detailed information on this subject, visit the HP web site. Go to www.hp.com/support, select your country/region and your language, then type HP Photosmart 8700 in the product/name search box. Press ENTER and then select the HP Photosmart 8700 series printer. In the Question or keywords search box enter lightfastness or permanence and then press ENTER. Click the topic you want to review.

To keep your paper in good condition for printing:

- Store the photo paper in its original packaging or in a resealable plastic bag.
- Keep the paper flat in a cool, dry place. If the corners curl, place the paper in a plastic bag and gently bend it in the opposite direction until it lies flat.
- Hold photo paper by the edges to avoid smears.

Using specialty papers

Note  HP recommends using the Main tray for these specialty medias, but the rear feed slot can be used for stiffer medias. Check the HP web site at www.hp.com/support for more information about printing with fine art media.

Your HP printer also prints on a variety of non-HP specialty media. Experiment with some of the types listed here for special effects:

- Smooth Fine Art Paper
- William Turner Textured Surface
- German Etching
- Photo Rag
- Photo Rag Smooth Surface
- Fine Art Water Color
- Soft Fine Art Water Color
- Photo Rag Duo
- Soft Suede
- Gallery Gloss

Some media types may not be available in all countries/regions. Check with your local media provider.

Warning  Do not use photo board as it can damage the printer.
**Loading your paper**

The HP Photosmart 8700 series supports the following paper sizes:

<table>
<thead>
<tr>
<th>Supported paper sizes</th>
<th>When printing from a computer</th>
<th>When printing from the printer control panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>● From 76 x 127 mm (3 x 5 inches) up to 324 x 476 mm (13 x 19 inches)</td>
<td>● 3.5 x 5 inches</td>
<td>● 4 x 6 inches</td>
</tr>
<tr>
<td>● 216 mm (8.5 inch-wide) banner paper</td>
<td>● 5 x 7 inches</td>
<td>● 8 x 10 inches</td>
</tr>
<tr>
<td></td>
<td>● 8.5 x 11 inches</td>
<td>● 11 x 14 inches</td>
</tr>
<tr>
<td></td>
<td>● 13 x 19 inches</td>
<td>● 13 x 18 cm</td>
</tr>
<tr>
<td></td>
<td>● 10 x 15 cm (with or without tab)</td>
<td>● A3</td>
</tr>
<tr>
<td></td>
<td>● 13 x 18 cm</td>
<td>● A4</td>
</tr>
<tr>
<td></td>
<td>● A6</td>
<td>● L</td>
</tr>
<tr>
<td></td>
<td>● 2L</td>
<td>● 2L</td>
</tr>
<tr>
<td></td>
<td>● Hagaki</td>
<td></td>
</tr>
</tbody>
</table>

Paper loading tips:

- Before loading paper, slide out the paper-width and length guides to make room for the paper. After loading paper, adjust the guides to fit close to the edges of the paper without bending the paper.
- Load only one type and size of paper at a time in the same tray.
- After loading paper, extend the Out tray extension to hold your printed pages. This prevents printed pages from dropping off of the Out tray.

Use the directions in the following table to load the most commonly used paper sizes into the printer.
### Paper type

**Any supported photo or plain paper media**

1. Raise the Out tray (4).
2. Load paper print-side down. Press the Main tray release (2) and pull out the tray if needed for easier access. Check that the stack of paper is no higher than the top of the paper-length guide (3).
3. Adjust the Main tray paper-width guide (1), as needed.
4. Lower the Out tray (4).

### How to load

**Any supported photo or plain paper media—ideal for envelopes**

1. Load paper print-side down into the front feed slot (1). If you are using tabbed paper, insert the paper so the tab feeds in last.
2. Adjust the front feed slot paper-width guide (3), as needed.

### Tray to load

**Main tray**

1. Main tray paper-width guide
2. Main tray release
3. Paper-length guide
4. Out tray

**Front feed slot**

1. Front feed slot
2. Out tray
3. Front feed slot paper-width guide

**Rear feed slot**

1. Rear feed slot
2. Rear feed slot paper-width guide

### Tips

- To avoid jams and paper skewing, load one sheet at a time straight into the slot
- Use only stiff stock media
- Do not use for photo board or banner printing
- Only use this slot when printing from a computer. Not for use when printing from the printer’s control panel.

**Stiff media, such as cardstock (Not supported: photo board and banner printing)**

1. Load paper print-side up into the rear feed slot (1).
2. Adjust the rear feed slot paper-width guide (2), as needed.
Inserting print cartridges

The HP Photosmart 8700 series printer can print color and black-and-white photos, as well as documents. HP provides different types of print cartridges so you can choose the best cartridges for your project. The HP Photosmart 8700 series supports the HP Blue Photo print cartridge for color prints with richer blues and better color transitions.

Note The cartridge numbers you can use with this printer appear on the back cover of the printed HP Photosmart 8700 series User's Guide. If you have already used the printer several times, you can find the cartridge numbers in the HP Photosmart 8700 series Toolbox. Windows users: Right-click the small printer icon on the far right of the Windows taskbar, and select Open HP Photosmart 8700 series Toolbox. Click the Estimated Ink Level tab and then click the Print Cartridge Ordering Information button. Macintosh users: Click HP Image Zone in the Dock. Choose Maintain Printer from the Settings pop-up menu. Click Utilities, and then choose Supplies from the pop-up menu.

For optimum printing results, HP recommends using only HP print cartridges. Inserting a cartridge that is not in this table may invalidate the printer warranty.

Use the correct print cartridges

<table>
<thead>
<tr>
<th>To print...</th>
<th>Insert this print cartridge in the left stall</th>
<th>Insert this print cartridge in the middle stall</th>
<th>Insert this print cartridge in the right stall</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full-color photos</td>
<td>□ HP Blue Photo</td>
<td>△ HP Tri-color</td>
<td>□ HP Gray Photo</td>
</tr>
<tr>
<td>Black-and-white photos</td>
<td>□ HP Blue Photo</td>
<td>△ HP Tri-color</td>
<td>□ HP Gray Photo</td>
</tr>
<tr>
<td>Sepia or antique photos</td>
<td>□ HP Photo</td>
<td>△ HP Tri-color</td>
<td>□ HP Gray Photo</td>
</tr>
<tr>
<td>Text and colored line drawings</td>
<td>□ HP Photo</td>
<td>△ HP Tri-color</td>
<td>□ HP Black</td>
</tr>
</tbody>
</table>

Caution Check that you are using the correct print cartridges. Also, note that HP does not recommend modifying or refilling HP cartridges. Damage that
results from modifying or refilling HP cartridges is not covered by the HP warranty.

For best print quality, HP recommends that you install all retail print cartridges before the date stamped on the box.

### Insert or replace the print cartridges

#### Prepare the printer and cartridges

1. Make sure you have removed the cardboard from inside the printer and the power is on.
2. Lift the main cover of the printer.
3. Remove the bright pink tape from all cartridges.

Do not touch the ink nozzles or the copper-colored contacts, and do not re-tape the cartridges.

#### Insert the cartridges

1. If you are replacing a cartridge, push down and pull outward on the cartridge stall cover to open it and then pull the cartridge out.
2. Match the symbol on the cartridge label to the correct stall.
3. Hold the cartridge with the label on top and slide it at a slight upward angle into the stall so the copper-colored contacts go in first. Push the cartridge until it snaps into place.
4. Close the cartridge stall cover.
5. Repeat the previous steps to install the other cartridges, if necessary.
6. When you are finished installing cartridges, close the main cover.

You must install all three cartridges in order for the printer to work as intended.

#### Tip

**Ink-backup printing mode** lets you keep printing even if one of the cartridges fails or runs out of ink. Remove the cartridge and close the main cover to enter ink-backup printing mode. The printer continues to print, but at a slower speed and with inferior print quality. A message reminds you that the printer is in ink-backup printing mode. Replace the cartridge as soon as possible.

The idle screen of the printer displays three icons showing the approximate ink level for each
cartridge (100%, 75%, 50%, 25%, and nearly empty). Ink-level icons do not appear if any of the installed cartridges are not genuine HP cartridges.

Each time you install or replace a print cartridge, a message prompts you to print an alignment page. This ensures high-quality prints.

**Align the cartridges**

1. Load paper in the Main tray.
2. Follow the onscreen instructions to complete the cartridge alignment.

See Aligning the print cartridges.

---

**When you are not using a print cartridge**

Whenever you remove a print cartridge from the printer, store it in a print cartridge protector. The cartridge protector keeps the ink from drying out. Storing the cartridge improperly can cause the cartridge to malfunction. A print cartridge protector comes in the box with the printer.

➔ To insert a cartridge into the cartridge protector, slide the cartridge into the protector at a slight angle and snap it securely into place.

Once you have inserted a cartridge into the cartridge protector, place it in the storage area located under the top cover.
3 Basic printing from a computer

You'll need to save your photos to the computer before you can use them with the printer driver software that lets you print photos from a computer. For more information, see Saving photos to a computer from a memory card.

For information on installing the printer driver software, see the setup instructions that came in the box with the printer.

Be sure to download the latest printer software update every couple of months to ensure you have the latest features and improvements. For more information, see Updating the software.

The print driver software is the interface that appears whenever you print. This section describes the print quality settings available for the HP Photosmart 8700 series in the print driver and how to select the most appropriate setting for the current print job.

Note The onscreen HP Photosmart Printer Help provides more information on the many print settings available when you print from a computer. To learn how to access the onscreen help, see Finding more information.

To set print quality settings
1. Open the Print dialog box.
   - If you are using a Windows computer
     ➔ Click the Paper/Quality tab in the Print dialog box (Windows 2000/XP) or click Properties in the Print dialog box and then click the Paper/Quality tab (Windows 98).
   - If you are using a Macintosh
     a. Choose Paper Type/Quality in the Copies & Pages pop-up menu.
     b. Click the Paper tab.

2. Select a setting from the Print quality (Windows) or Quality (Macintosh) pop-up menu:
   - **Fast Draft**: This 300 dpi setting provides the fastest speed and the most economical use of ink. Use it for proof copies of your photo or creative project. Print outs appear light.
   - **Fast Normal**: This 300 dpi setting provides the fastest speed for good quality prints. Use it for proof copies of your photos.
   - **Normal**: This 600 dpi setting provides the best balance between print quality and speed. Use it for your final prints.
   - **Best**: This 600 dpi setting provides the best balance between high quality and speed, and uses PhotoREt color enhancement. Use it for high quality prints.
   - **Maximum dpi**: This 4800 x 1200 dpi setting provides the highest quality prints possible, but requires long print times and a large amount of free disk space.
For more information on the HP print driver, do the following:

- **Windows**: From the **Start** menu, select **Programs** (in Windows XP, select **All Programs** > **HP > Photosmart 320, 370, 7400, 8100, 8400, 8700 series > Photosmart Help**, then click **HP Photosmart Printer Help**. In the print dialog itself, right-click any option and click the **What's This?** box to learn more about that option.

- **Macintosh**: Select **Help > Mac Help** in the Finder, then select **Library > HP Photosmart Printer Help**.

**Note** For more information on color settings in the print driver, see Using color management.
Using color management

This section provides some basic information about using color management with the HP Photosmart 8700 series. For more detailed information on this complex subject, visit the HP web site. Go to www.hp.com/support, select your country/region and your language, then type HP Photosmart 8700 in the product/name search box. Press ENTER and then select the HP Photosmart 8700 series printer. In the Question or keywords search box enter color management and then press ENTER. Click the topic you want to review.

In many cases, the default printer-based color management of the HP Photosmart 8700 series delivers good results, but if you need to have greater control over color management in your workflow, see Using application-based color management.

Color management allows the colors in images or graphics to pass accurately between applications, operating systems, and imaging devices, such as cameras, scanners, monitors, and printers.

Digital cameras, scanners, and monitors use the RGB\(^1\) color model, while commercial printers use the CMYK\(^2\) color model. The differences between the two color models can cause printed photos to look markedly different from what you see on the monitor.

**Warning** It's possible to have color management features turned on both in the printer driver and in an application such as Adobe® Photoshop®. This double correction produces unsatisfactory results. Use either printer-based or application-based color management, but not both at the same time.

**Note** Color management is a complex subject and a detailed discussion is beyond the scope of this user guide. The HP Photosmart 8700 series User Guide provides a couple of typical examples, but for more information, see the documentation that came with your third-party image-editing software.

Using printer-based color management

The HP Photosmart 8700 series offers built-in automatic color management that's easy to configure. Printer-based color management produces attractive results and should be adequate for many users.

For information on a more advanced, professional-level form of color management, see Using application-based color management.

---

1 The RGB color model is so-named because it creates colors by mixing red, green, and blue colored light. Technologies that rely on light (monitors, scanners, or digital cameras) use this model.

2 The CMYK color model used in the printing industry is based on the light-absorbing qualities of ink printed on paper. CMYK stands for cyan, magenta, yellow, and black, the colors used in four-color process printing.
Printer driver color mode settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>When to use it</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Colorsmart/sRGB</strong></td>
<td>• When your digital camera, scanner, or image editing software is set to sRGB</td>
</tr>
<tr>
<td></td>
<td>• For the easiest, most basic form of color management</td>
</tr>
<tr>
<td></td>
<td>• When you are not using ICC profiles</td>
</tr>
<tr>
<td><strong>Adobe RGB or Adobe RGB (1998)</strong></td>
<td>• When your digital camera, scanner, or image editing software is set to Adobe RGB</td>
</tr>
<tr>
<td></td>
<td>• For high-quality digital photography</td>
</tr>
<tr>
<td></td>
<td>• When you are not using ICC profiles</td>
</tr>
<tr>
<td><strong>Managed by Application (Windows)</strong></td>
<td>• When you want to use ICC profiles</td>
</tr>
<tr>
<td><strong>Application Managed Colors (Mac OS)</strong></td>
<td>• When you want to use the color management features of imaging editing software, such as Adobe Photoshop</td>
</tr>
<tr>
<td></td>
<td>• For the greatest level of control over color quality</td>
</tr>
</tbody>
</table>

Tip: You should not have the printer set to this mode if you are also using ICC profiles and your application to manage color. This can result in decreased color fidelity since the colors are converted twice—first by the application and then by the printer.
### Setting

<table>
<thead>
<tr>
<th>Setting</th>
<th>When to use it</th>
</tr>
</thead>
<tbody>
<tr>
<td>both in the printer driver and in your applications, and requires ICC profiles for all your devices. For more information, see <a href="#">Using application-based color management</a>.</td>
<td></td>
</tr>
</tbody>
</table>

In order to print using the color management features built into the HP Photosmart 8700 series, you have to change settings in the printer driver software and in the image editing software. Here is one example of a typical print job using printer-based color management with Adobe Photoshop (version 7 or CS).

**To print using printer-based color management**

1. Open the file you want to print in Adobe Photoshop.
2. Select **File > Print with Preview** in Adobe Photoshop. Make sure **Show More Options** is selected in the **Print with Preview** dialog box, then select **Color Management** from the pop-up menu.
3. In the **Print Space** area of the **Print with Preview** dialog box, select the same RGB color space setting you intend to use in the print driver (Windows). In most cases this is sRGB or Adobe RGB. On a Macintosh, choose **Printer Color Management** instead.
4. Click **Page Setup** in the **Print with Preview** dialog box, set up the page for the current image, as desired, then click **OK**.
5. Click **Print**.

**If you are using a Windows computer**

a. Click **Properties** in the **Print** dialog box.

b. Click the **Color** tab in the **Properties** dialog box.

c. Select a color mode from the **Color management** pop-up menu in the **Print** dialog box:
   - Colorsmart/sRGB (default)
   - AdobeRGB

Select the same color mode you selected as an RGB working space in the Adobe Photoshop **Color Settings** dialog box.

d. Click the **Paper/Quality** tab, select the desired paper type from the **Type is** pop-up menu, then click **OK**.

**If you are using a Macintosh**

a. Choose **Paper Type/Quality** in the **Print** dialog box.

b. Choose a color mode from the **Color** pop-up menu in the **Print** dialog box:
   - Colorsmart/sRGB
   - AdobeRGB

Select the same color mode you selected as an RGB working space in the Adobe Photoshop **Color Settings** dialog box.

6. Click **OK** in the **Print** dialog box to begin printing.
Tip  For best results when printing photos in black and white, make sure you install the HP Gray Photo print cartridge and select the Print in Grayscale option in the Print dialog box (Windows) or the Grayscale option in the Color pop-up menu of the Print dialog box (Mac OS). For finer control over the conversion of color photos to black and white, use image editing software to control the conversion.

Using application-based color management

Application-based color management offers more sophisticated control than the printer-based form, but also involves greater complexity and more steps.

For information on the printer-based color management built into the HP Photosmart 8700 series, see Using printer-based color management.

Using application-based color management can involve:

- **Using device profiles**: Application-based color management relies on files called ICC device profiles. An ICC profile describes a device’s color space. The software component of your color management system uses these profiles to convert colors between each device’s color space. The HP Photosmart 8700 series Typical software installation installs HP ICC profiles automatically for the printer.

- **Calibrating the monitor**: Monitors exhibit a color degradation over time that can interfere with producing professional quality printed photography. As a result, the ICC profile that comes with most new monitors gradually becomes invalid and no longer accurately reflects the color space available on the device. Calibrating the monitor at least once a month to produce a custom ICC profile is the best way to ensure that the color space available on the monitor is accurately defined for your color management system. You can calibrate a monitor visually using system or utility software, such as Adobe Gamma, but this type of calibration does not meet the high-quality standards expected for professional photography. Professionals usually invest in a calibration kit consisting of software and a piece of hardware that captures the current state of the RGB environment on the monitor and saves it as a custom ICC profile. Monitor calibration kits are available from GretagMacBeth, Monaco Systems, and LaCie, as well as other manufacturers.

In order to print using application-based color management features, you have to change settings in the printer driver software and in the image editing software. Here is one example of a typical print job using application-based color management in Adobe Photoshop (version 7 or CS). See the documentation that came with your image-editing software for complete instructions on using the product’s color management features.

**To print using application-based color management**

1. Open the photo you want to print in Adobe Photoshop.
2. Select **File > Print with Preview** in Adobe Photoshop.
3. Make sure **Show More Options** is checked in the Print with Preview dialog box, then select **Color Management** from the pop-up menu.

---

3 International Color Consortium. ICC enables profile-based color management solutions. For more information, see www.color.org.
4. In the Print Space area of the Print with Preview dialog box, select the appropriate HP Photosmart 8700 series profile for the paper and ink set you are using. The HP Photosmart printer software installer installed several profiles for you automatically.

5. Select Perceptual from the Intent pop-up menu. Checking the Use Black Point Compensation option is also recommended.

6. Click Page Setup in the Print with Preview dialog box, set up the page for the current image, as desired, then click OK.

7. Click Print in the Print with Preview dialog box.
   
   If you are using a Windows computer
   a. Click Properties in the Print dialog box.
   b. Click the Color tab in the Print dialog box.
   c. Select Managed by application from the Color Management area of the Print dialog box, then click OK.
   d. Click the Paper/Quality tab, select an appropriate paper type from the Type Is pop-up menu, then click OK.
   e. Click OK in the Print dialog box to begin printing.

   If you are using a Macintosh
   a. Choose Paper Type/Quality in the Print dialog box.
   b. Choose Application Managed Colors in the Color pop-up menu.
   c. Select an appropriate paper type from the Paper pop-up menu.

8. Click Print in the Print dialog box.
5 Exploring creative projects

The HP Image Zone software that comes with the printer provides tools that make using photos in creative projects possible, as well as access to HP Instant Share, an online service that makes sharing photos with others easy. For more information on all the features of the HP Image Zone software, see the onscreen HP Photosmart Printer Help. See Finding more information.

Note You must select the Typical option when you install the printer software or the HP Image Zone will not be installed.

This section contains information about:
- Using large-format templates in scrapbooking and other projects
- Using the HP Image Zone
- Printing borderless photos from a computer

The large-format templates

Large-format templates consist of a plain white background with fixed picture holders into which you can drag photos. Photos are automatically cropped by the picture holders. You can resize the photos and move them around within the picture holder.

Scrapbookers: be sure to visit the HP Scrapbooking web site at www.hp.com/go/scrapbooking. It's a great place to obtain free art downloads, layout ideas, scrapbooking tips, information about purchasing supplies, other online scrapbooking resources, and more. The site is available in English only.

<table>
<thead>
<tr>
<th>Template page size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Standard U.S./Imperial size. Also known as Ledger or US Legal. 11 x 17 inches. Approximately 279 x 432 mm.</td>
</tr>
<tr>
<td>B+</td>
<td>Standard U.S./Imperial size. Also known as Super B. 13 x 19 inches. Approximately 330 x 483 mm.</td>
</tr>
<tr>
<td>A3</td>
<td>Standard ISO size. 297 x 420 mm. Approximately 11.7 x 16.5 inches.</td>
</tr>
<tr>
<td>A3+</td>
<td>Standard ISO size. Also known as Super A3. 330 x 483 mm. Approximately 13 x 19 inches.</td>
</tr>
<tr>
<td>12 x 12 inches</td>
<td>Standard U.S./Imperial size. Also known as Photo 12 x 12. Popular for use in scrapbooking albums. Approximately 305 x 305 mm.</td>
</tr>
</tbody>
</table>
To place photos in a template

1. Select some photos and place them in a large-format template. You can move a photo around in a template’s picture holder.

If you are using a Windows computer

a. In HP Image Zone on the Projects tab, click Album Pages.
b. In the Work area, click a page size.
c. Click a large-format template.
d. Select photos from the My Images tab, then drag each photo from the Selection Tray into the desired page holder in the template.

If you are using a Macintosh

a. Click HP Image Zone in the Dock.
b. Click Services, then double-click HP Image Print in the HP Image Zone window.
c. Select one or more photos, then click Open. You can add additional photos to the Drawer later by clicking the + button. If the Drawer is not visible, click the Drawer button.
d. Choose Album Page in the Print Style pop-up menu.
e. Press the Select Template arrows to select a template.
f. Drag each photo from the Drawer into the desired picture holder in the template.
g. Click Page Setup to select a paper size from the Paper Size pop-up menu, and then click OK.
h. Click Print.

For more information on the best print settings to use for quality printing from a computer, see Basic printing from a computer.

Scrapbookers: add a new level of creativity and energy to your scrapbooking experience with HP Creative Scrapbook Assistant software. The powerful digital tools and hundreds of included high-quality, ready-made theme images in this affordable, innovative software make it fun to plan, create, archive, print, and share your scrapbook elements and pages. It’s a new scrapbooking tool that’s the perfect complement to the HP Photosmart 8700 series. Learn more about this software at the HP Scrapbooking web site: www.hp.com/go/scrapbooking. The software and web site are in English only. HP Creative Scrapbook Assistant may not be available in all countries/regions.

The HP Image Zone

Note You must select the Typical option when you install the printer software or the HP Image Zone will not be installed.

Use the HP Image Zone to get creative with your pictures: edit them, share them, and create fun projects such as greeting cards. To work with photos, you need to transfer them to a computer that you have connected to the printer. Insert a memory card with
photos. Follow the instructions on the computer screen to save them to your computer. For more information, see Saving photos to a computer from a memory card.

The HP Image Zone lets you:

- Use your photos for creative projects, such as scrapbooking albums, greeting cards, and iron-on transfers
- Organize your photos in albums and search through them by keyword and dates (Windows only)
- Edit and enhance your photos by adding text or doing color correction
- Share your photos online through HP Instant Share with family and friends

For more information on the HP Image Zone, explore the onscreen HP Photosmart Printer Help:

- **Windows**: From the Start menu, select Programs (in Windows XP, select All Programs) > HP > Photosmart 320, 370, 7400, 8100, 8400, 8700 series > Photosmart Help, then click Use the HP Image Zone.
- **Macintosh**: Select Help > Mac Help in the Finder, then select Library > HP Image Zone Help.

## Printing borderless photos from a computer

The quickest and easiest way to print a borderless photo from your computer is by using the HP Image Zone. The HP Image Zone is available on your computer if you selected Typical during the software installation.

**Note** You can also do borderless printing from within other imaging software. This section only includes instructions for printing borderless photos from the HP Image Zone.

### Printing a borderless photo from Windows

1. Load photo paper in the printer.
2. Open the HP Image Zone, then choose a photo to print.
3. Click Print, then in the HP Print window click Quick Print, if it is not already selected.
4. Make sure the Borderless sizes only option is checked, then select the desired size from the Paper Size pop-up menu.
5. Enter the number of copies in Copies of Current Image.
6. Click Print.

### Printing a borderless photo from a Macintosh

1. Load photo paper in the printer.
2. Click HP Image Zone in the Dock.
3. Double-click HP Image Print in the HP Image Zone window.
4. Choose one or more photos to print, then click Open.
5. Choose Photo Print from the Print Style pop-up menu, if it is not already chosen.
6. Choose the HP Photosmart 8700 series printer from the Printer pop-up menu.
7. Choose a borderless paper size from the Paper Size menu.
8. Make sure the Print Borderless option is checked, then click Print Now.
6 Printing photos without a computer

The HP Photosmart 8700 series printer lets you select and print photos without even turning on the computer. Once you've set up the printer using the setup instructions that came in the box with the printer, you can print from any of the following:

- Memory card
- PictBridge-compatible digital camera
- Bluetooth device

Connecting to other devices

This printer offers several types of connectivity that do not require a computer, such as memory cards, PictBridge cameras, and devices with Bluetooth wireless technology. Each connection type lets you do different things.

<table>
<thead>
<tr>
<th>Connection type and what you need</th>
<th>This lets you...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Memory cards</strong></td>
<td></td>
</tr>
<tr>
<td>![Memory Card Icon]</td>
<td></td>
</tr>
<tr>
<td>A memory card</td>
<td></td>
</tr>
<tr>
<td>A compatible digital camera memory card</td>
<td>Insert the memory card into the appropriate memory card slot on the front of the printer.</td>
</tr>
<tr>
<td></td>
<td>● Print directly from a memory card to the printer.</td>
</tr>
<tr>
<td></td>
<td>● Print quick proofs of photos on a memory card directly from the printer control panel.</td>
</tr>
<tr>
<td></td>
<td>● Save photos from a memory card inserted in the printer to a computer where you can enhance or organize them in the HP Image Zone or other software. For more information, see Saving photos to a computer from a memory card and Printing photos from a memory card.</td>
</tr>
<tr>
<td><strong>PictBridge</strong></td>
<td></td>
</tr>
<tr>
<td>![PictBridge Icon]</td>
<td></td>
</tr>
<tr>
<td>The PictBridge symbol</td>
<td></td>
</tr>
<tr>
<td>A PictBridge-compatible digital camera and a USB cable. Connect the camera to the camera port on the front of the printer.</td>
<td>Print directly from a PictBridge-compatible digital camera to the printer. For more information, see Printing photos from a digital camera and the camera documentation.</td>
</tr>
</tbody>
</table>
Table of contents

Chapter 6

Connection type and what you need

<table>
<thead>
<tr>
<th>Bluetooth</th>
</tr>
</thead>
<tbody>
<tr>
<td>The HP bt300 Bluetooth® wireless printer adapter (Model: Q3395A)</td>
</tr>
</tbody>
</table>

The HP bt300 Bluetooth wireless printer adapter goes into the camera port on the front of the printer and lets you use Bluetooth wireless technology for printing. See the documentation that came with the adapter and the onscreen HP Photosmart Printer Help for instructions.

This lets you...

Print from any device with Bluetooth wireless technology to the printer. For more information, see the documentation that came with the adapter.

The adapter is not compatible with the Macintosh.

Printing photos from a memory card

You can print photos from a memory card by inserting the card into the printer and using the printer control panel to select, enhance, and print photos. You can also print camera-selected photos—photos you marked for printing using a digital camera—directly from a memory card.

Printing from a memory card is quick and easy, and does not drain the digital camera batteries. For more information on inserting memory cards, see Inserting memory cards.

Printing from a memory card is easy. This section tells you how to do the following:

- Insert a memory card
- Decide which photos to print
- Select a photo layout
- Select photos
- Improve photo quality
- Print the selected photos

Inserting memory cards

After you have taken pictures with a digital camera, you can remove the memory card from the camera and insert it into the printer to print your photos or save them to a computer. The printer can read the following types of memory cards: CompactFlash™, Memory Sticks, Microdrive™, MultiMediaCard™, Secure Digital™, and xD-Picture Card™.

Caution Using any other type of memory card may damage the memory card and the printer.

To learn about other ways of transferring photos from a digital camera to the printer, see Connecting to other devices.
**Supported file formats**

The printer can recognize and print the following file formats directly from the memory card: JPEG and uncompressed TIFF. If a digital camera saves photos and video clips in other file formats, save the files to a computer and print them using a software application. For more information, see the onscreen HP Photosmart Printer Help.

**Inserting a memory card**

Find the memory card in the following table and use the instructions to insert the card into the printer.

### Guidelines:

- Insert only one memory card at a time.
- Gently push the memory card into the printer until it stops. The memory card does not insert all the way into the printer; do not try to force it.

**Caution** Inserting the memory card any other way may damage the card and the printer.

When the memory card is inserted correctly, the Memory Card light flashes and then remains solid green.

**Caution** Do not pull out a memory card while the Memory Card light is flashing. For more information, see Removing a memory card.
### Memory card

<table>
<thead>
<tr>
<th>Memory card</th>
<th>How to insert the memory card</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CompactFlash</strong></td>
<td>• Front label faces up, and if the label has an arrow, the arrow points toward the printer</td>
</tr>
<tr>
<td></td>
<td>• Edge with metal pinholes goes into the printer first</td>
</tr>
<tr>
<td><strong>Memory Stick</strong></td>
<td>• Angled corner is on the left</td>
</tr>
<tr>
<td></td>
<td>• Metal contacts face down</td>
</tr>
<tr>
<td></td>
<td>• If you are using a Memory Stick Duo™ or Memory Stick PRO Duo™ card, attach the adapter that</td>
</tr>
<tr>
<td></td>
<td>came with the card before you insert the card into the printer</td>
</tr>
<tr>
<td><strong>Microdrive</strong></td>
<td>• Front label faces up, and if the label has an arrow, the arrow points toward the printer</td>
</tr>
<tr>
<td></td>
<td>• Edge with metal pinholes goes into the printer first</td>
</tr>
<tr>
<td><strong>MultiMediaCard</strong></td>
<td>• Angled corner is on the right</td>
</tr>
<tr>
<td></td>
<td>• Metal contacts face down</td>
</tr>
<tr>
<td><strong>Secure Digital</strong></td>
<td>• Angled corner is on the right</td>
</tr>
<tr>
<td></td>
<td>• Metal contacts face down</td>
</tr>
<tr>
<td><strong>xD-Picture Card</strong></td>
<td>• Curved side of card points toward you</td>
</tr>
<tr>
<td></td>
<td>• Metal contacts face down</td>
</tr>
</tbody>
</table>

### Saving photos to a computer from a memory card

You can save photos to a computer from any memory card inserted in the printer, if you have set up a USB connection between the two devices. You'll need to save the photos to your computer in order to use them in image editing software, such as the HP Image Zone. You must select **Typical** when you install the printer software or the HP Image Zone software will not be installed on your computer.

1. Insert a memory card into the printer.
If you are using a Windows computer
a. Select Copy pictures to a folder on my computer using Microsoft Scanner and Camera Wizard.
b. Follow the onscreen prompts.

Note The memory card also appears in Windows Explorer as a removable drive. You can open it and drag photos from the card to any location on your computer.

If you are using a Macintosh
a. Wait for iPhoto to start and read the contents of the memory card.
b. Click Import to save the photos on the card to your Macintosh.

Note The memory card also appears on the desktop as a drive icon. You can open it and drag photos from the card to any location on your Macintosh.

Removing a memory card
Wait until the Memory Card light stops flashing, then gently pull the memory card to remove it from the printer.

Caution Do not pull out a memory card while the Memory Card light is flashing. A flashing light means that the printer is accessing the memory card. Removing a memory card while it is being accessed may damage the printer and the memory card or corrupt the information on the memory card.

Deciding which photos to print
You can decide which photos to print from a memory card by printing a photo index and using the index numbers to select photos.

A photo index shows thumbnail views and index numbers for up to 2000 photos on a memory card. When printing an index page, use plain paper instead of photo paper to cut costs.

A photo index may be several pages long.

To print a photo index:
1. Insert a memory card.
2. Load several sheets of plain paper in the Main tray.
3. Press the Index page button, then press .

Selecting a photo layout
Press Layout on the printer to select a layout for the photos you want to print. All photos selected from the printer control panel will print in this layout. If you are not
using the **1 photo borderless** layout, the actual size of the prints will vary according to the size of paper you load in the printer, as shown in the following table.

**Note**  The printer may rotate the photos to fit the layout.

<table>
<thead>
<tr>
<th>Layout</th>
<th>Paper size (photo size)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 photo borderless</td>
<td>The photo fills the page to match the paper size.</td>
</tr>
<tr>
<td>1 photo per page, bordered</td>
<td>3.5 x 5 inches (3.25 x 4.75 inches)</td>
</tr>
<tr>
<td></td>
<td>4 x 6 inches (3.75 x 5.75 inches)</td>
</tr>
<tr>
<td></td>
<td>5 x 7 inches (4.75 x 6.75 inches)</td>
</tr>
<tr>
<td></td>
<td>8 x 10 inches (7.75 x 9.75 inches)</td>
</tr>
<tr>
<td>2 photos per page</td>
<td>8.5 x 11 inches (8 x 10 inches)</td>
</tr>
<tr>
<td></td>
<td>A6 (98.6 x 141.6 mm)</td>
</tr>
<tr>
<td></td>
<td>A4 (200 x 250 mm)</td>
</tr>
<tr>
<td></td>
<td>A3 (290.6 x 413.5 mm)</td>
</tr>
<tr>
<td></td>
<td>10 x 15 cm (95.2 x 146 mm)</td>
</tr>
<tr>
<td></td>
<td>13 x 18 cm (120.6 x 171.4 mm)</td>
</tr>
<tr>
<td></td>
<td>Hagaki (93.6 x 141.6 mm)</td>
</tr>
<tr>
<td></td>
<td>L (82.5 x 120.6 mm)</td>
</tr>
<tr>
<td>2 photos per page</td>
<td>3.5 x 5 inches (2.25 x 2.25 inches)</td>
</tr>
<tr>
<td></td>
<td>4 x 6 inches (2.75 x 3.75 inches)</td>
</tr>
<tr>
<td></td>
<td>5 x 7 inches (3.25 x 4.75 inches)</td>
</tr>
<tr>
<td></td>
<td>8 x 10 inches (4.75 x 6.5 inches)</td>
</tr>
<tr>
<td>2 photos per page</td>
<td>8.5 x 11 inches (5 x 7 inches)</td>
</tr>
<tr>
<td></td>
<td>A6 (69.2 x 98.6 mm)</td>
</tr>
<tr>
<td></td>
<td>A4 (130 x 180 mm)</td>
</tr>
<tr>
<td></td>
<td>A3 (204.2 x 272.3 mm)</td>
</tr>
<tr>
<td></td>
<td>10 x 15 cm (69.2 x 98.6 mm)</td>
</tr>
<tr>
<td>Layout</td>
<td>Paper size (photo size)</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>13 x 18 cm (84.1 x 120.6 mm)</td>
</tr>
<tr>
<td></td>
<td>Hagaki (68 x 93.6 mm)</td>
</tr>
<tr>
<td></td>
<td>L (58.7 x 82.5 mm)</td>
</tr>
<tr>
<td>3 photos per page</td>
<td>3.5 x 5 inches (1.5 x 2.25 inches)</td>
</tr>
<tr>
<td></td>
<td>4 x 6 inches (1.75 x 2.625 inches)</td>
</tr>
<tr>
<td></td>
<td>5 x 7 inches (2.25 x 3.375 inches)</td>
</tr>
<tr>
<td></td>
<td>8 x 10 inches (3.33 x 5 inches)</td>
</tr>
<tr>
<td></td>
<td>8.5 x 11 inches (4 x 6 inches)</td>
</tr>
<tr>
<td></td>
<td>11 x 14 inches (5 x 7.5 inches)</td>
</tr>
<tr>
<td></td>
<td>13 x 19 inches (6 x 9 inches)</td>
</tr>
<tr>
<td></td>
<td>A6 (47.7 x 71.5 mm)</td>
</tr>
<tr>
<td></td>
<td>A4 (100 x 150 mm)</td>
</tr>
<tr>
<td></td>
<td>A3 (139.7 x 209.6 mm)</td>
</tr>
<tr>
<td></td>
<td>10 x 15 cm (45.7 x 69 mm)</td>
</tr>
<tr>
<td></td>
<td>13 x 18 cm (58.7 x 88 mm)</td>
</tr>
<tr>
<td></td>
<td>Hagaki (45.2 x 67.8 mm)</td>
</tr>
<tr>
<td></td>
<td>L (39.6 x 59.4 mm)</td>
</tr>
<tr>
<td>4 photos per page</td>
<td>3.5 x 5 inches (1.5 x 2.25 inches)</td>
</tr>
<tr>
<td></td>
<td>4 x 6 inches (1.75 x 2.5 inches)</td>
</tr>
<tr>
<td></td>
<td>5 x 7 inches (2.2 x 3.25 inches)</td>
</tr>
<tr>
<td></td>
<td>8 x 10 inches (3.5 x 4.75 inches)</td>
</tr>
<tr>
<td></td>
<td>8.5 x 11 inches (3.5 x 5 inches)</td>
</tr>
<tr>
<td></td>
<td>11 x 14 inches (4.75 x 6.75 inches)</td>
</tr>
<tr>
<td></td>
<td>13 x 19 inches (5 x 7 inches)</td>
</tr>
<tr>
<td></td>
<td>A6 (47.7 x 69.2 mm)</td>
</tr>
<tr>
<td></td>
<td>A4 (90 x 130 mm)</td>
</tr>
<tr>
<td></td>
<td>A3 (133.4 x 190.5 mm)</td>
</tr>
<tr>
<td></td>
<td>10 x 15 cm (45.7 x 66 mm)</td>
</tr>
<tr>
<td></td>
<td>13 x 18 cm (58.7 x 84.1 mm)</td>
</tr>
<tr>
<td></td>
<td>Hagaki (45.2 x 65 mm)</td>
</tr>
<tr>
<td></td>
<td>L (39.6 x 57 mm)</td>
</tr>
</tbody>
</table>
Selecting photos to print

You select the photos you want to print by using the printer control panel.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Follow these steps</th>
</tr>
</thead>
</table>
| Select a photo    | 1. Insert a memory card.  
                    2. Press ‹ or › to display the index number of the photo you want to select.  
                    3. Press b to select the photo.  
                    The index number appears in the Selected photos area of the printer screen.  
                    4. To select additional photos, repeat steps 2 and 3. |
| Deselect a photo  | 1. Press ‹ or › to display the photo you want to deselect.  
                    2. Press Cancel to deselect the displayed photo for printing. |
| Deselect all photos | 1. Press Cancel until a message appears on the printer screen asking if you want to deselect all photos.  
     2. Press g. |

Note: Deselecting photos does not delete them from the memory card.
Improving photo quality

The printer lets you improve the brightness or contrast of any photo printed from a memory card. These print settings do not change the original photo. They only affect printing.

<table>
<thead>
<tr>
<th>Problem</th>
<th>How to correct it</th>
</tr>
</thead>
</table>
| Photos with poor brightness    | 1. Press **Menu**.  
                          2. Press ▲ until **Digital Flash** appears, then click 
                          3. Press ▲ until **On** appears, then press       |
| Blurred photos                 | 1. Press **Menu**.  
                          2. Press ▲ until **AutoFocus** appears, then click 
                          3. Press ▲ until **On** appears, then press       |

Doing common printing tasks from a memory card

This section describes some of the most common printing tasks you might want to do from a memory card.

If you want to… | Follow these steps:
--- | ---
Print a borderless photo | 1. Press **Layout** on the printer until **Layout: 1 photo borderless** appears on the printer screen.  
2. Select the photo or photos you want to print. For more information, see Selecting photos to print.  
3. Press **Print**.  
Change the print quality to Normal for one print job | 1. Press **Menu**.  
2. Select **Print quality**, then press 
3. Select **Normal**, then press 
Print quality will revert to Best after the next print job.  
Print one or more photos | 1. Press the **Layout** button to select a photo layout. Select **Layout: 1 photo borderless** for borderless prints.  

## If you want to...  
Follow these steps:

| Paper tray you want to use is loaded with the correct paper. | 2. Press ‼ or ‷ to display the index number of the photo you want to print, then press ‡. You can repeat steps 1 and 2 to select more photos.  
3. Press Print. |
|---|---|

### Print all photos on the memory card

Before you begin, make sure that the memory card is inserted in the printer and the paper tray you want to use is loaded with the correct paper.

| 1. Press the **Layout** button to select a photo layout. Select **Layout: 1 photo borderless** for borderless prints.  
2. Press **Menu**.  
3. Select **Print all**, then press ‡ to begin printing all photos on the memory card. |
|---|---|

### Print a continuous range of photos

Before you begin, make sure that the memory card is inserted in the printer and the paper tray you want to use is loaded with the correct paper.

| 1. Press the **Layout** button to select a photo layout. Select **Layout: 1 photo borderless** for borderless prints.  
2. Press ‼ or ‷ until the first photo you want to print appears on the printer screen, then press and hold ‡ for at least two seconds.  
3. Press ‼ or ‷ until the last photo you want to print appears on the printer screen, then press ‡.  
The selected range of photos begins printing. |
|---|---|

### Print camera-selected photos from a memory card

When you select photos for printing using a digital camera, the camera creates a Digital Print Order Format (DPOF) file that identifies the selected photos. The printer can read DPOF 1.0 and 1.1 files directly from a memory card.

| 1. Use the digital camera to select the photos you want to print. For more information, see the documentation that came with the camera.  
2. If you select **default** as the photo layout with the camera, press the **Layout** button on the printer to select a photo layout.  
If you select a photo layout other than **default** with the camera, photos print in the camera-selected layout regardless of the printer setting.  
3. Load photo paper.  
4. Remove the memory card from the digital camera and insert it into the printer.  
5. When a message appears on the printer screen asking if you want to print the camera-selected photos, press ‡.  
The photos you selected with a camera will print.  
If the printer cannot find or read all of the camera-selected photos on the card, it will print those photos that it can read.  
After printing, the printer deletes the DPOF file and unmarks the photos. |
|---|---|
Printing photos from a digital camera

You can print photos by connecting a PictBridge digital camera directly to the camera port of the printer with a USB cable. If you have a digital camera with Bluetooth wireless technology, you can insert the optional HP Bluetooth® wireless printer adapter in the printer and send photos to the printer wirelessly.

When you print from a digital camera, the printer uses the settings that you selected on the camera. For more information, see the documentation that came with the camera.

Using a PictBridge camera

Using a PictBridge camera with the printer is easy and fast.

1. Turn on the PictBridge digital camera and select the photos you want to print.
2. Load photo paper in the printer.
3. Make sure the camera is in PictBridge mode, then connect it to the camera port on the front of the printer using the USB cable that came with the camera.
   Once the printer recognizes the PictBridge camera, the selected photos print automatically.

Using a Bluetooth camera

If you have a digital camera with Bluetooth wireless technology, you can purchase the optional HP Bluetooth® wireless printer adapter and print from a camera using a Bluetooth wireless connection.

1. Load photo paper in the printer and check that the paper tray you want to use is engaged.
2. Insert the HP Bluetooth® wireless printer adapter into the camera port on the front of the printer. The light on the adapter will flash when the adapter is ready to receive data.
3. Follow the instructions in the documentation that came with the digital camera to send photos to the printer.

Printing from other Bluetooth devices

You can also print from other devices with Bluetooth wireless technology besides digital cameras, such as PDAs, laptops, and mobile phones. For more information, see Connecting to other devices, the onscreen HP Photosmart Printer Help, and the documentation that came with the device with Bluetooth wireless technology.

Note To use Bluetooth connectivity, all devices must have the necessary hardware and software installed. In addition, an HP Bluetooth® wireless printer adapter must be connected to the camera port on the front of the printer. The adapter is available separately. For more information, see the documentation that came with the adapter.

The basic procedure for printing from any device with Bluetooth wireless technology is the same:
1. Have the device search for available Bluetooth printers.
2. Select the printer when it appears on the device.
3. Print.

Check the documentation that came with the device for detailed instructions.
7 Care and maintenance

The HP Photosmart 8700 series printer requires very little maintenance. Follow the guidelines in this section to extend the life span of the printer and printing supplies, and to ensure that the photos you print are always of the highest quality.

Cleaning and maintaining the printer

Keep the printer and print cartridges clean and well maintained using the simple procedures in this section.

Cleaning the outside of the printer

1. Turn off the printer, then disconnect the power cord from the back of the printer.
2. Wipe the outside of the printer with a soft cloth that has been lightly moistened with water.

Caution Do not use any type of cleaning solution. Household cleaners and detergents may damage the printer finish. Do not clean the interior of the printer. Keep all fluids away from the interior. Do not lubricate the metal rod on which the print cartridge cradle slides. Noise is normal when the cradle moves back and forth.

Automatically cleaning the print cartridges

If you notice white lines or single-color streaks on the photos you print, the print cartridges may need to be cleaned. Do not clean the cartridges more often than necessary, since cleaning uses up ink. Follow the steps in this section to run an automatic cartridge-cleaning procedure.

1. Press Menu on the printer control panel.
2. Select Clean cartridges, then press .
3. Following the directions on the printer screen, load paper so the printer can print a test page after cleaning the cartridges. Use plain paper to conserve photo paper.
4. Press to begin cleaning the print cartridges.
5. When the printer finishes cleaning the cartridges and prints a test page, it asks whether you want to Continue to second level cleaning. Check the test page and select from the following options:
   - If the test page has white streaks or missing colors, the print cartridges need to be cleaned again. Select to continue to a second level cleaning.
   - If the print quality of the test page looks good, press Cancel.

You can clean the cartridges up to three times. Each successive cleaning is more thorough and uses more ink.

If you complete all three levels of cleaning using this procedure and you still notice white streaks or missing colors on the test page, you may need to clean the print
cartridge contacts. For more information, see Manually cleaning the print cartridge contacts.

Note If a cartridge has been recently dropped, you may also see white streaks or missing colors in your prints. This problem is temporary and clears up within 24 hours.

Manually cleaning the print cartridge contacts

If you use the printer in a dusty environment, debris may accumulate on the copper-colored contacts and cause printing problems.

To clean the print cartridge contacts:
1. Gather the following items to clean the contacts:
   – Distilled water (tap water may contain contaminants that can damage the print cartridge)
   – Cotton swabs or other soft, lint-free material that will not stick to the print cartridge
2. Open the top cover of the printer.
3. Remove the print cartridge and place it on a piece of paper with the ink nozzle plate facing up. Be careful not to touch the copper-colored contacts or the ink nozzle plate with your fingers.

Caution Do not leave the print cartridge outside the printer for more than 30 minutes. Ink nozzles exposed to the air longer than this may dry out and cause printing problems.

4. Lightly moisten a cotton swab with distilled water and squeeze any excess water from the swab.
5. Gently wipe the copper-colored contacts with the cotton swab.

Caution Do not touch the ink nozzle plate. Touching the ink nozzle plate will result in clogs, ink failure, and bad electrical connections.

6. Repeat steps 4 and 5 until no ink residue or dust appears on a clean swab.
7. Insert the print cartridge in the printer, then close the top of the printer.

Printing a test page

You can print a test page to check the condition of the print cartridges.
1. Press Menu on the printer control panel.
2. Select Print test page, then press .

The test page contains the following information:
Aligning the print cartridges

The first time you install a print cartridge in the printer, the printer performs a printer calibration automatically to align the cartridges. However, if colors in the photos you print are misaligned, or if the alignment page does not print correctly when you install a new print cartridge, use the following procedure to calibrate the printer manually. This process aligns the print cartridges.

1. Press Menu on the printer control panel.
2. Select Calibrate the printer, then press ✔.

Printing a sample page

You can print a sample page to test the printer photo printing quality and to make sure the paper is loaded correctly.

1. Load paper in the Main tray. Use plain paper to conserve photo paper.
2. Press Menu on the printer control panel.
3. Select Print a sample page, then press ✔.

Updating the software

Download the latest printer software update periodically to ensure you have the latest features and improvements. You can download printer software updates by going to www.hp.com/support or by using HP Software Update.

Note  The printer software update that you download from the HP web site does not update the HP Image Zone software.
**Downloading the software (Windows)**

- **Note** Make sure you are connected to the Internet before you use HP Software Update.

1. From the Windows **Start** menu, select **Programs** (in Windows XP, select **All Programs**) > **Hewlett-Packard** > **HP Software Update**. The HP Software Update window opens.

2. Click **Check Now**. HP Software Update searches the HP web site for printer software updates. If the computer does not have the most recent version of the printer software installed, a software update appears in the HP Software Update window.

   - **Note** If the computer has the most recent version of the printer software installed, the following message appears in the HP Software Update window: “No updates are available for your system at this time”.

3. If a software update is available, click the checkbox next to the software update to select it.

4. Click **Install**.

5. Follow the onscreen instructions to complete the installation.

**Downloading the software (Macintosh)**

- **Note** Make sure you are connected to the Internet before you use HP Photosmart Updater.

1. On your Macintosh in the Finder, choose **Go** > **Applications**.

2. Choose **Hewlett-Packard** > **Photosmart** > **HP Photosmart Updater**.

3. Follow the onscreen instructions to check for software updates.

   - If you are behind a firewall, you need to enter the proxy server information in the updater.

**Storing the printer**

The printer is built to withstand long or short periods of inactivity.

- Store the printer indoors out of direct sunlight in a place without temperature extremes.
- If the printer and print cartridges have not been used for one month or more, clean the print cartridges before printing. For more information, see **Automatically cleaning the print cartridges**.

**Maintaining the supplies**

For best results with photo paper, follow the guidelines in this section.
Storing photo paper

- Store the photo paper in its original packaging or in a resealable plastic bag.
- Store the packaged photo paper on a flat, cool, and dry surface.
- Return unused photo paper to the plastic bag. Paper left in the printer or exposed to the elements may curl.

Handling photo paper

- Always hold photo paper by the edges to avoid fingerprints.
- If the photo paper has curled edges, place it in its plastic storage bag and gently bend it in the opposite direction of the curl until the paper lies flat.

Storing the print cartridges

When you store the printer, always leave the active print cartridges inside the printer. The printer stores the print cartridges in a protective cap during the power-down cycle.

⚠️ Caution ⚠️ Make sure the printer completes its power-down cycle before you unplug the power cord. This allows the printer to store the print cartridges properly.

Follow these tips to help maintain HP print cartridges and ensure consistent print quality:

- When you remove a print cartridge from the printer, store it in a print cartridge protector to prevent the ink from drying out. For more information, see Inserting print cartridges.
- Keep all unused print cartridges in their original sealed packages until they are needed. Store print cartridges at room temperature (15–35 degrees C or 59–95 degrees F).
- Do not remove the plastic tape covering the ink nozzles until you are ready to install the print cartridge in the printer. If the plastic tape has been removed from the print cartridge, do not attempt to reattach it. Reattaching the tape damages the print cartridge.
Troubleshooting

The HP Photosmart printer is designed to be reliable and easy to use. This chapter answers frequently asked questions about using the printer and printing without a computer. It contains information about the following topics:

- Printer software installation problems
- Printer hardware problems
- Printing problems
- Error messages

For additional troubleshooting information, see:

Printer software and printing from a computer troubleshooting: The onscreen HP Photosmart Printer Help. For information about viewing the onscreen HP Photosmart Printer Help, see Finding more information.

Printer software installation problems

Note Before contacting HP Customer Care, read this section for troubleshooting tips or go to the online support services at www.hp.com/support. The name of HP’s support services may vary by country/region.

If the printer software did not install successfully or if the printer and computer are not communicating properly after software installation, check this section for possible solutions.

Check all cable connections between the printer and computer, and ensure that you are using the most recent version of the printer software.

The System Requirements dialog box appears during installation

- **Cause** A component of the computer system does not meet minimum system requirements.
- **Solution** Upgrade the component to the minimum system requirement and then reinstall the printer software.

The computer could not read the HP Photosmart CD

- **Solution** Make sure the CD isn’t dirty or scratched. If other CDs work but the HP Photosmart does not, you may have a damaged CD. You can request a new CD from HP Customer Care. If other CDs don’t work, you may need to service the CD-ROM drive.

The installation software does not start automatically when the CD is inserted (Windows only)
Solution From the Windows Start menu, select Run. Click Browse, then navigate to the CD drive where you inserted the HP Photosmart CD. Double-click the setup.exe file.

The Found New Hardware Wizard opens but doesn’t recognize the printer (Windows only)

Cause You may have connected the USB cable before completing the software installation.
Solution Disconnect the USB cable and restart the software installation. Connect the USB cable when prompted during software installation.

The system requirements check indicates that the computer is running an outdated version of Internet Explorer (Windows only)

Solution Press CTRL + SHIFT on the keyboard and click Cancel in the System Requirements dialog box to bypass the block and complete the software installation. You must update Internet Explorer immediately after installing the HP Photosmart software, or the HP software will not work properly. You do not have to reinstall the HP software after updating Internet Explorer.

The computer stops responding during software installation

Cause Virus protection software or another software program is running in the background and slowing down the installation process.
Solution Wait while the software finishes copying files; this may take several minutes. If, after several minutes, the computer is still not responding, restart the computer, pause or disable any active virus protection software, quit all other software programs, and then reinstall the printer software.

Printer hardware problems

Note 1 Before contacting HP Customer Care, read this section for troubleshooting tips or go to the online support services at www.hp.com/support. The name of HP’s support services may vary by country/region.

Note 2 If you want to connect the printer to a computer with a USB cable, HP recommends using a cable of less than 3 meters (10 feet) in length to minimize injected noise due to potential high electromagnetic fields.

The Status light is flashing green but the printer is not printing
Solution The printer is busy processing information; wait for it to finish.

The Status light is flashing amber or red
The Status light flashed amber briefly after I turned the printer off

Solution  This is a normal part of the power-down process; it does not indicate a problem with the printer.

The printer does not find the photos I stored on my memory card

Cause  The memory card may contain file types the printer cannot read directly from the card.

Solution
- Save the photos to a computer, then print them from the computer. For more information, see the onscreen HP Photosmart Printer Help and the documentation that came with the camera.
- The next time you take photos, set the digital camera to save them in a file format the printer can read directly from the memory card. For a list of supported file formats, see Printer specifications. For instructions on setting the digital camera to save photos in specific file formats, see the documentation that came with the camera.

The memory card may need to be reformatted if the problem persists.

The printer is plugged in but will not turn on

Solution
- The printer may have drawn too much power. Unplug the printer's power cord. Wait about 10 seconds, then plug the cord back in. Turn on the printer.
- The printer may be plugged into a power strip that is turned off. Turn on the power strip, then turn on the printer.
- The power cord could be defective. Make sure the green light on the power cord is lit.

The printer makes noises when I turn it on, or starts making noises after sitting unused for a while
Solution  The printer may make noises after long periods of inactivity (approximately 2 weeks) or when its power supply has been interrupted and then restored. This is normal operation. The printer is performing an automatic maintenance procedure to ensure it produces the best quality output.

Printing problems

Note  Before contacting HP Customer Care, read this section for troubleshooting tips or go to the online support services at www.hp.com/support. The name of HP’s support services may vary by country/region.

The printer does not print borderless photos when I print from the control panel

Solution  Press the Layout button until Layout: 1 photo borderless appears, then try to print again.

Printing is very slow

Cause  You may be printing a PDF or a project containing high-resolution graphics or photos. Large, complex projects containing graphics or photos print slower than text documents.

Solution  Consider using lower resolution graphics in the project, if possible, or allow for longer print times in your workflow.

Cause  The printer may be in Ink-Backup Printing Mode. The printer enters this mode when one of the print cartridges has been removed or is out of ink.

Solution  Replace the missing or empty cartridge.

Paper does not feed into the printer correctly from the Main tray

Solution

● There may be too much paper loaded in the tray. Remove some paper and try printing again.

● The paper guides may not be adjusted correctly. Make sure the paper-width and paper-length guides fit close to the edges of the paper without bending the paper.

● Two or more pieces of paper may be sticking together. Remove the paper from the Main tray, fan the edges of the stack to separate the sheets of paper, then reload the paper and try printing again.

● If the paper is wrinkled or bent, try using different paper.

● The paper may be too thin or too thick. Use HP inkjet paper for best results. For more information, see Choosing the right paper.

Printed pages are dropping off of the Out tray
Solution Always extend the Out tray extension when you print.

The printout is rippled or curled

Solution The project you are printing uses a larger amount of ink than normal. Print the project from a computer, and use the printer software to lower the ink saturation level. See the onscreen HP Photosmart Printer Help for more information.

The document printed at an angle or is off-center

Solution
- The paper may not be loaded correctly. Reload the paper, making sure it is correctly oriented in the Main tray and that the paper-width and paper-length guides fit close to the edges of the paper. For paper-loading instructions, see Loading your paper.
- The printer may need to be calibrated. For more information, see Aligning the print cartridges.

Colors are not printing satisfactorily

Solution
- You may not be using the best print cartridges for the project. For more information, see Inserting print cartridges.
- You may be printing in Ink-Backup Printing Mode. The printer enters Ink-Backup printing mode when one of the print cartridges is missing. Replace the missing cartridge.
- A cartridge is out of ink. Replace it.
- Some of the ink nozzles on a cartridge are clogged. Clean the cartridges. See Automatically cleaning the print cartridges.
- The color management settings of the printer may not be set properly. For more information, see Using color management.

No page came out of the printer or the paper jammed while printing

Solution
- The printer may need attention. Read the printer screen for instructions.
- The power may be off or there may be a loose connection. Make sure the power is on and the power cord is securely connected.
• You may not have any paper in the Main tray, front feed slot, or rear feed slot. Check that the paper is loaded correctly. For paper-loading instructions, see Loading your paper.

• If the paper jammed while printing, try the following:
  – Turn off the printer, then unplug it from the power source. Clear the printer of any paper obstructing the paper path. Remove the rear access door. Gently remove the jammed paper from the printer, then replace the rear access door. Plug the printer back in and turn it on. Try printing again.
  – If you were printing labels, make sure a label did not become unglued from the label sheet while going through the printer.

Banner paper jams between the Main and Out trays

**Solution**  There is too much banner paper in the Main tray. Clear the paper jam.

A blank page came out of the printer

**Solution**

• Check the ink-level icons on the printer screen. Replace any empty print cartridges. For more information, see Inserting print cartridges.

• You may have begun printing and then cancelled the process. If you cancelled the process before printing started, the printer may have already loaded paper in preparation for printing. The next time you print, the printer will eject the blank page before starting the new printing project.

• You may be printing in Ink-Backup Printing Mode with only the black print cartridge installed and borderless printing turned on. Replace the missing print cartridge with a new one or turn off borderless printing. For more information about printing in Ink-Backup Printing Mode, see Inserting print cartridges.

The photo did not print using the printer’s default print settings

**Solution**  You may have changed the print settings for the selected photo. Print settings you apply to an individual photo override the printer’s default print settings. Discard all print settings that have been applied to an individual photo by deselecting the photo. For more information, see Selecting photos to print.

The printer ejects the paper when preparing to print

**Solution**  Direct sunlight could be interfering with the operation of the automatic paper sensor. Move the printer out of direct sunlight.

Print quality is poor
Solution
● You may be printing in Ink-Backup Printing Mode. The printer enters Ink-Backup Printing Mode when one of the print cartridges is missing. Replace the missing cartridge. For more information, see Inserting print cartridges.
● One of the print cartridges may be running out of ink. If a cartridge is running low on ink, replace it. For more information, see Inserting print cartridges.
● Use photo paper designed for the printer. For best results, use HP inkjet paper.
● You may be printing on the wrong side of the paper. Make sure the paper is loaded with the side to be printed facing down.
● You may have selected a low-resolution setting on the digital camera. Reduce the size of the image and try printing again. For better results in the future, set the digital camera to a higher photo resolution.
● There may be a problem with a print cartridge. Try the following:
  – Remove and then reinsert the print cartridges.
  – Run an automatic print cartridge cleaning procedure from the printer control panel. For more information, see Automatically cleaning the print cartridges.
  – Calibrate the printer from the control panel. For more information, see Aligning the print cartridges.
  – Clean the copper-colored contacts on the print cartridges. For more information, see Manually cleaning the print cartridge contacts.
  – If these solutions do not work, replace the print cartridge(s).

Photos are not printing correctly

Solution
● You may have loaded the photo paper incorrectly. Load the photo paper with the side to be printed facing down.
● The photo paper may not have fed into the printer correctly. Try the following:
  – Check for a paper jam.
  – Insert the photo paper as far as it will go into the front feed slot.
  – Load one sheet of photo paper at a time.

The photos I marked for printing in the digital camera do not print

Solution
Some digital cameras let you mark photos for printing in both the camera's internal memory and on the memory card. If you mark photos in the internal memory, and then move photos from the camera's internal memory to the memory card, the marks do not transfer. Mark photos for printing after you transfer them from the digital camera's internal memory to the memory card.

The photo is clipped when I print it

Cause
You have transferred a photo from your computer to a memory card, inserted the card into the printer, and then tried to print the photo from the printer.
control panel. This can cause clipping of the photo or change its size ratio in unexpected ways.

Solution Print the photo from the computer to avoid this distortion.

Error messages

Note Before contacting HP Customer Care, read this section for troubleshooting tips or go to the online support services at www.hp.com/support. The name of HP’s support services may vary by country/region.

Error messages that appear on the printer screen can be divided into the following types:

- Paper errors
- Print cartridge errors
- Memory card errors
- Computer printing errors
- Network errors

Paper errors

Before contacting HP Customer Care, read this section for troubleshooting tips or go to the online support services at www.hp.com/support. The name of HP’s support services may vary by country/region.


Solution Turn off the printer, then unplug it from the power source. Clear the printer of any paper that may be obstructing the paper path. Remove the rear access door. Gently remove the jammed paper from the printer, then replace the rear access door. Plug the printer back in and turn it on.

Error message: Out of paper. Load paper then press ⌘.

Solution Load paper, then press ⌘ to print again. For paper-loading instructions, see Loading your paper.

Error message: Unsupported media size.

Solution The printer cannot use the size of paper loaded in the paper tray. Press ⌘, then load a supported paper size instead. For a list of supported paper sizes, see Printer specifications.

Error message: Automatic paper sensor failed.

Solution The automatic paper sensor is obstructed or damaged. Try moving the printer out of direct sunlight, then press ⌘ and try printing again. If this does
not work, go to www.hp.com/support or contact HP Customer Care. The name of HP’s support services may vary by country/region.

---

**Error message: Paper size mismatch**

**Cause** The size of the paper in the paper tray does not match the photo size selected to print.

**Solution** Load a paper size that matches the photo size selected to print. For paper-loading instructions, see Loading your paper.

---

**Print cartridge errors**

Before contacting HP Customer Care, read this section for troubleshooting tips or go to the online support services at www.hp.com/support. The name of HP’s support services may vary by country/region.

**Error message: Cartridge failed.**

**Solution** The specified print cartridge may be old or damaged. Remove the cartridge and then reinstall it. For more information, see Inserting print cartridges. If this does not work, replace the cartridge.

---

**Error message: Cartridge failed. Replace it, or remove it to print using ink-backup printing mode.**

**Solution** Remove the cartridge and then reinstall it. For more information, see Inserting print cartridges. If this does not work, replace the cartridge. You can also print in Ink-Backup Printing Mode by removing the damaged cartridge.

---

**Error message: One or more cartridges have failed. Please remove all cartridges. Reinsert them one at a time, closing the main door each time, to see which cartridges have failed.**

**Solution** A print cartridge is old or damaged. Follow these steps to test print cartridges to see if one or more failed:

1. Remove all of the print cartridges.
2. Reinsert one of the print cartridges in its appropriate print cartridge cradle.
3. Close the main door. If the printer screen states that the inserted print cartridge has failed, replace it.
4. Remove the print cartridge, then repeat steps 2–3 with the untested print cartridges.

---

**Error message: Color cartridge not compatible. Use appropriate HP cartridge. — OR — Photo cartridge not compatible. Use appropriate HP cartridge. — OR — Right cartridge not compatible. Use appropriate HP cartridge.**
Solution You have inserted a print cartridge that does not work with the printer. Replace the cartridge with one that is compatible with the printer. For more information, see Inserting print cartridges.

Error message: Color Cartridge is not installed correctly. Please remove and reinsert it. —OR— Photo Cartridge is not installed correctly. Please remove and reinsert it. —OR— Cartridge is not installed correctly. Please remove and reinsert it.

Solution Remove the specified cartridge and reinstall it. For more information, see Inserting print cartridges.

Error message: Color Cartridge is missing. —OR— Photo Cartridge is missing. —OR— Cartridge is missing. Please install and snap cartridge in completely.

Solution Install the specified cartridge using the instructions in Inserting print cartridges.

Error message: Color Cartridge is low on ink. —OR— Photo Cartridge is low on ink. —OR— Cartridge is low on ink. You may need to replace it soon, or remove it to print using ink-backup printing mode.

Solution Replace the specified cartridge. For more information, see Inserting print cartridges.

Error message: One or more cartridges have failed.

Solution Replace the failed cartridges with new HP print cartridges. For more information, see Inserting print cartridges.

Error message: One or more cartridges are not compatible.

Solution One or more of the print cartridges are not HP print cartridges. Replace the non HP cartridges with supported HP print cartridges. For more information, see Inserting print cartridges.

Error message: One or more cartridges are not installed correctly.

Solution Remove the print cartridges that are not installed correctly and then reinstall them following the procedures in Inserting print cartridges.

Error message: One or more cartridges are low on ink.

Solution Replace the print cartridges that have low ink levels with new HP factory-filled print cartridges. For more information, see Inserting print cartridges.
**Error message: Cartridge service station is stuck.**

**Solution**  There is an obstruction blocking the path of the cartridge service station. The print cartridge service station is located beneath the print cartridge cradle when the printer is in an inactive state. Follow these steps to clear the obstruction:
1. Lift the top cover to access the print cartridges.
2. Clear any obstruction blocking the path of the cartridge service station.
3. Close the top cover.
4. Press the button to continue.

**Error message: Print cartridge cradle is stuck. Clear jam then press ✓.**

**Solution**  Follow these steps to clear any obstruction in the path of the print cartridge cradle:
1. Lift the top cover to access the print cartridges.
2. Clear any obstruction in the cradle path.
3. Close the top cover.
4. Press the ✓ button to continue.
   The current page will eject and the print job will continue on the next available sheet of paper.

**Error message: Top cover is open.**

**Solution**  Close the top cover of the printer.

---

**Memory card errors**

Before contacting HP Customer Care, read this section for troubleshooting tips or go to the online support services at [www.hp.com/support](http://www.hp.com/support). The name of HP’s support services may vary by country/region.

**Error message: Photo is missing. —OR— Some photos are missing.**

**Solution**  The printer cannot read the file on the memory card or one or more files specified for the job are missing from the memory card. Try saving the photos to the computer using the digital camera rather than the memory card. If a photo is missing, you may have accidentally deleted the photo from the card.

**Error message: Card access error. Job was cancelled. See computer for details. Press ✓. —OR— File directory structure is corrupted. —OR— Card may be damaged. Job was cancelled. See computer for details. Press ✓.**

**Cause**  The printer cannot read the data on the memory card and cannot complete any current print or save jobs. The data may be corrupted or there may be a physical problem with the memory card.
Solution

- Save the files to the computer and access them from there.
- If this does not work, use a new memory card or reformat the memory card using the digital camera. Any photos on the memory card will be lost.
- If this does not work, the photo files may be damaged or unreadable. Before you contact HP Customer Care, try another memory card to determine if it is the printer or the memory card that is failing.

Error message: Can not print photos.

Cause  More than 10 photos specified for a print job may be corrupt, missing, or are an unsupported file type. For information about supported file types, see Printer specifications.

Solution

- Save the photos to the computer using the digital camera rather than the memory card.
- Save the files to the computer and print from the computer.
- Print a photo index page and reselect photos. For more information, see Deciding which photos to print.

Error message: Card is password protected. Can not access card.

Solution  The printer cannot read the memory card because the card is password-protected. Follow these steps:

1. Remove the memory card from the printer.
2. Insert the memory card in the device you originally used to store the password on the memory card.
3. Remove the password from the memory card using the same software you used to store the password.
4. Remove the memory card and reinsert it in the printer memory card slot.
5. Try printing again.

Error message: Card is locked. Can not access card.

Solution  Make sure the lock switch on the card is in the unlocked position.

Error message: Card is not fully inserted. Push card in a little more.

Solution  The printer can detect the memory card but cannot read it. Push the memory card gently into the memory card slot until it stops. For more information, see Inserting a memory card.

Error message: Use only 1 card at a time. Please remove a memory card.
Solution  The printer has two or more different types of memory cards inserted simultaneously or a memory card inserted and a digital camera connected to the camera port at the same time. Remove memory cards or disconnect the camera until only one card is in the printer or one camera is connected.

Error message: Card was removed. Job was cancelled. Press 📷.

Solution  You removed a memory card from the printer while it was busy printing a file from the card or saving files to the computer. Follow these steps:

1. Press the 📷 button.
2. Reinsert the memory card and print selected photos or saved files again. The memory card must remain inserted until the print or save job is complete.

To avoid damage to memory cards in the future, do not remove them from the printer memory card slot while they are being accessed. For more information, see Removing a memory card.

Error message: Camera selections (DPOF) file has error.

Solution  The printer is unable to read a DPOF file due to corrupted data or an error on the memory card. Use the printer control panel to reselect the photos. For more information, see Printing photos from a memory card.

Error message: Some camera-selected photos are not on card.

Solution  Some camera-selected photos are missing or have been deleted. Try the following:

- Confirm that you did not accidentally delete the photo from the memory card.
- Reselect the photos again using the digital camera.
- Print a new photo index page to see the index numbers associated with each photo. For more information, see Deciding which photos to print.

Error message: No new photos on card.

Solution  There are no new photos on the memory card, or the photos have already been printed once. Select and print the desired photos.

Error message: Cannot display this photo.

Solution  The memory card contains image formats the printer does not support or the file is corrupted. For a list of supported image formats, see Printer specifications. Access photos using the computer. For information about accessing photos through the computer, see Basic printing from a computer.

Error message: Memory card in backwards. The black side should face up.
Solution  The memory card has been inserted upside down. Remove the memory card and reinsert it with the gold contacts facing down. For more information, see Inserting a memory card.

Computer printing errors

Before contacting HP Customer Care, read this section for troubleshooting tips or go to the online support services at www.hp.com/support. The name of HP’s support services may vary by country/region.

Error message: Printer memory is full. Job was cancelled. Press ⬤.

Solution  The printer encountered a problem when saving files to the computer. Try the following:

● To clear the printer memory, turn the printer off, then turn it on again.
● Print fewer photos at a time.
● Save the photos to the computer and print from there.
● Save the files to the computer using a memory card reader and then print from the computer.

Error message: Computer is not connected. To save photos...connect printer to computer. Press ⬤. —OR— Communication error. Check computer connection. Press ⬤. —OR— Data was not received. Check computer connection. Press ⬤ to continue. —OR— No response from computer.

Solution  The printer cannot communicate properly with the computer. A printer driver may not be working or a cable may be loose. Make sure the USB cable is securely attached to both the computer and to the USB port on the back of the printer. If the cable is secure, verify that the printer software is installed.

Network errors

Before contacting HP Customer Care, read this section for troubleshooting tips or go to the online support services at www.hp.com/support. The name of HP’s support services may vary by country/region. You can also find help with networking the printer by going to the home page of the embedded web server in the printer. See To access help for the embedded web server.

Error message: Network not connected.

Solution  The printer cannot find the network. Make sure the Ethernet cable is properly connected to the Ethernet port and the network. If your network requires a proxy IP address, access the embedded web server to set the proxy server settings. See Using the embedded web server.
Note The name of HP’s support services may vary by country/region.

If you have a problem, follow these steps:

1. Check the documentation that came with the printer.
   - **Quick Start booklet** or **Setup Guide**: The HP Photosmart 8700 series printer comes with setup instructions that explain how to set up the printer and install the printer software. Which document you receive with the printer varies by country/region.
   - **User’s Guide**: The User’s Guide is the book you are reading. This book describes the basic features of the printer, explains how to use the printer without connecting a computer, and contains hardware troubleshooting information.
   - **HP Photosmart Printer Help**: The onscreen HP Photosmart Printer Help describes how to use the printer with a computer and contains software troubleshooting information.

2. If you are unable to solve the problem using the information in the documentation, visit www.hp.com/support to do the following:
   - Access online support pages
   - Send HP an e-mail message for answers to your questions
   - Check for software updates
   - Connect with an HP technician by using Real Time Chat

Support options and availability vary by product, country/region, and language.

3. **For Europe only**: Contact your local point of purchase. If the printer has a hardware failure, you will be asked to bring the printer to where you purchased it. Service is free during the printer limited warranty period. After the warranty period, you will be quoted a service charge.

4. If you are unable to solve the problem using the onscreen HP Photosmart Printer Help or HP web sites, call HP Customer Care using the number for your country/region. For a list of country/region phone numbers, see HP Customer Care by phone.

**HP Customer Care by phone**

While the printer is under warranty, you can obtain free phone support. For more information, see the warranty information included in the box, or go to www.hp.com/support to check the duration of your free support.

After the free phone support period, you can obtain help from HP at an additional cost. Contact your HP dealer or call the support phone number for your country/region for support options.

To receive HP support by phone, call the appropriate support phone number for your location. Standard phone company charges apply.

**North America**: Call 1-800-HP-INVENT (1-800-474-6836). U.S. phone support is available in both English and Spanish languages 24 hours a day, 7 days a week (days
and hours of support may change without notice). This service is free during the warranty period. A fee may apply outside the warranty period.

**Western Europe:** Customers in Austria, Belgium, Denmark, Spain, France, Germany, Ireland, Italy, Netherlands, Norway, Portugal, Finland, Sweden, Switzerland, and the United Kingdom should go to www.hp.com/support to access phone support numbers in their country/region.
Support for the following countries/regions is available at www.hp.com/support: Austria, Belgium, Central America & The Caribbean, Denmark, Spain, France, Germany, Ireland, Italy, Luxembourg, Netherlands, Norway, Portugal, Finland, Sweden, Switzerland, and the United Kingdom.

<table>
<thead>
<tr>
<th>Country/Region</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina (Buenos Aires)</td>
<td>Argentina 54-11-4708-1600 0-800-555-5000</td>
</tr>
<tr>
<td>Australia</td>
<td>Australia (out-of-warranty) 1300 721 147 1902 910 910</td>
</tr>
<tr>
<td>Brasil (Sao Paulo)</td>
<td>Brasil 55-11-4004-7751 0-800-709-7751</td>
</tr>
<tr>
<td>Canada (Mississauga Area)</td>
<td>Canada (905) 206-4663 1-(800)-474-6836</td>
</tr>
<tr>
<td>Chile</td>
<td>800-360-999</td>
</tr>
<tr>
<td>China</td>
<td>021-3881-4518 800-810-3888 服务编码：3001</td>
</tr>
<tr>
<td>Colombia (Bogota)</td>
<td>Colombia 571-606-9191 01-8000-51-4746-8368</td>
</tr>
<tr>
<td>Costa Rica</td>
<td>0-800-011-1046</td>
</tr>
<tr>
<td>Česká republika</td>
<td>261 307 310</td>
</tr>
<tr>
<td>Ecuador (Andinatel)</td>
<td>1-999-119 0 800-711-2884</td>
</tr>
<tr>
<td>Ecuador (Pacifitel)</td>
<td>1-800-225-528 0 800-711-2884</td>
</tr>
<tr>
<td>2 532 5222</td>
<td>مصر</td>
</tr>
<tr>
<td>El Salvador</td>
<td>800-6160</td>
</tr>
<tr>
<td>Guatemala</td>
<td>1-800-711-2884</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>2802 4098</td>
</tr>
<tr>
<td>Malaysia</td>
<td>1 382 1111</td>
</tr>
<tr>
<td>Minha</td>
<td>1 600 44 7737</td>
</tr>
<tr>
<td>Indonesia</td>
<td>+62 (21) 350 3408</td>
</tr>
<tr>
<td>(0) 9 830 4848</td>
<td>+62 (21) 350 3408</td>
</tr>
<tr>
<td>Jamaica</td>
<td>1-800-711-2884</td>
</tr>
<tr>
<td>Japan</td>
<td>0570-000511 03-3335-9800</td>
</tr>
<tr>
<td>Japan (携帯電話の場合)</td>
<td>한국 1588-3003</td>
</tr>
<tr>
<td>Malaysia</td>
<td>1800 805 405</td>
</tr>
<tr>
<td>Mexico</td>
<td>Mexico 55-2528-9922 01-800-472-68368</td>
</tr>
<tr>
<td>New Zealand</td>
<td>0800 441 147</td>
</tr>
<tr>
<td>Nigeria</td>
<td>1 3204 999</td>
</tr>
<tr>
<td>Paraguay</td>
<td>009 800 54 1 0006</td>
</tr>
<tr>
<td>Peru</td>
<td>0-800-10111</td>
</tr>
<tr>
<td>Philippines</td>
<td>2 867 3551</td>
</tr>
<tr>
<td>Polska</td>
<td>22 5666 000</td>
</tr>
<tr>
<td>Republica Dominicana</td>
<td>1-800-711-2884</td>
</tr>
<tr>
<td>România</td>
<td>(21) 315 4442</td>
</tr>
<tr>
<td>Russian Federation</td>
<td>Russia (Moscow) 095 7973520 812 3467997</td>
</tr>
<tr>
<td>Singapore</td>
<td>6 272 5300</td>
</tr>
<tr>
<td>Slovakia</td>
<td>2 5022444</td>
</tr>
<tr>
<td>South Africa (International)</td>
<td>+ 27 11 2589301</td>
</tr>
<tr>
<td>South Africa (RSA)</td>
<td>086 0001030</td>
</tr>
<tr>
<td>Rest Of West Africa</td>
<td>+ 351 213 17 63 80</td>
</tr>
<tr>
<td>Taiwan</td>
<td>02-8722-8000</td>
</tr>
<tr>
<td>Thailand</td>
<td>+66 (2) 353 9000</td>
</tr>
<tr>
<td>Tunisia</td>
<td>71 89 12 22</td>
</tr>
<tr>
<td>Trinidad &amp; Tobago</td>
<td>1-800-711-2884</td>
</tr>
<tr>
<td>Türkiye</td>
<td>90 216 444 71 71</td>
</tr>
<tr>
<td>Украина</td>
<td>(380) 44 4903520</td>
</tr>
<tr>
<td>United States</td>
<td>United States 1-(800)-474-6836</td>
</tr>
<tr>
<td>Uruguay</td>
<td>0004-054-177</td>
</tr>
<tr>
<td>Venezuela</td>
<td>Venezuela 58-212-278-8666 0-800-474-68368</td>
</tr>
<tr>
<td>Vietnam</td>
<td>+84 88234530</td>
</tr>
</tbody>
</table>
Placing a call

Call HP Customer Care while you are near the computer and printer. Be prepared to provide the following information:

- Printer model number (located on the front of the printer).
- Printer serial number (located on the bottom of the printer).
- Computer operating system.
- Version of printer driver:
  - **Windows PC:** To see the printer driver version, right-click the memory card icon in the Windows taskbar and select *About*.
  - **Macintosh:** To see the printer driver version, use the Print dialog box.
- Messages displayed on the printer screen or on the computer monitor.
- Answers to the following questions:
  - Has the situation you are calling about happened before? Can you recreate the situation?
  - Did you install any new hardware or software on the computer around the time that the situation occurred?

Return to HP repair service (North America only)

HP will arrange to have your product picked up and delivered to an HP Central Repair Center. We pay for the round-trip shipping and handling. This service is free for the duration of the hardware warranty period. This service is available in North America only.

Additional warranty options

Extended service plans are available for the printer at additional costs. Go to www.hp.com/support, select your country/region and language, then explore the services and warranty area for information about the extended service plans.
Networking basics (Windows and Macintosh)

Networking lets networked devices, such as computers and printers, communicate with each other. A wired or ethernet network is the most common type of network in offices and in homes. The network adapter in the printer itself supports both 10 Mbps and 100 Mbps ethernet networks. To connect the printer to a network, you need a CAT-5 ethernet cable equipped with a RJ-45 plug. This is not the same as a USB cable. You must purchase the Ethernet cable separately. It is not included with the printer.

Caution Although the RJ-45 plug of a CAT-5 cable resembles a common telephone plug, it is not the same. Never use a regular phone wire to connect the printer to an ethernet network. You can damage the printer and other network devices by doing so.

The following illustration shows an example of the printer networked with several computers through a network hub, switch, or router. A cable or DSL modem links the hub and all the networked devices to broadband Internet access.
Networked devices connect to each other through a central device. The most common types include:

- **Hubs**: A simple, inexpensive network device that lets several computers communicate with each other or share a common printer. Hubs are passive. They only provide a way for communication to flow between other devices.
- **Switches**: Switches are similar to hubs, but can examine the information sent between devices and forward the information only to the proper device. They can lessen bandwidth usage on a network and help keep it running more efficiently.
- **Routers**: Routers or gateways connect both devices and networks. A common use is to connect several home computers on a network to the Internet. Routers often also include a built-in firewall that can help protect a home network from unauthorized access.

**Note** For specific information about setting up and configuring the hardware on your network, see the documentation that came with the hardware.

**Internet connection**

If your network is connected to the Internet through a router or gateway, it is recommended that you use a router or gateway that supports Dynamic Host Configuration Protocol (DHCP). A gateway with DHCP support manages a pool of reserved IP addresses that it assigns dynamically as needed. See the documentation that came with the router or gateway.

**Recommended network configurations**

The following network configurations support the printer. Determine the type of network configuration you have, then see Connecting the printer to the network and Installing the printer software on a Windows computer or Installing the printer software on a Macintosh for instructions on connecting your printer to the network and then installing the software.

- **Ethernet network without Internet access**
  The computers and printer communicate with each other, forming a simple network, through a hub. None of the networked devices has access to the Internet.

- **Ethernet network with Internet access by dial-up modem**
  The computers and printer communicate with each other, forming a simple network, through a hub. One of the computers has access to the Internet through a modem and dial-up account. None of the other networked devices, including the printer, have direct access to the Internet.

- **Ethernet network with broadband Internet access provided by a router**
  The printer is connected to a router that acts as a gateway between the user network and the Internet. This is the ideal network configuration.

**Connecting the printer to the network**

To connect the printer to a wired network, you need the following:

- A network access point such as a hub, router, or switch with an open port
- A CAT-5 ethernet cable with RJ-45 plug

**Note** You should not connect the printer directly to a computer using an ethernet cable. Peer-to-peer networking is not supported.

**Note** After you connect the printer to the network as described in this section, you must install the printer software. See Installing the printer software on a Windows computer or Installing the printer software on a Macintosh.
To connect the printer to the network
1. Connect the ethernet cable to the back of the printer.

![Ethernet connection on the back of the printer](image)

2. Connect the ethernet cable to an empty port on the hub, router, or switch.

After you finish connecting the printer to the network, install the printer software. You cannot print from a computer until you do the software installation.

- Installing the printer software on a Windows computer
- Installing the printer software on a Macintosh

**Installing the printer software on a Windows computer**

![Note](image)

Note Set up the printer as indicated in the setup instructions that came in the box.

Installation time can range from 20 minutes (Windows XP) to 1 hour (Windows 98), the amount of available hard drive space, and the processor speed of the computer. Make sure you have
already connected the printer to the network with an ethernet cable before you begin the installation.

Note The printer software must be installed as described in this section on every networked computer from which you want to print to the HP Photosmart 8700 series printer. After the installation, printing is identical to printing through a USB connection.

Tip Do not use the Windows Add Printer control panel utility to install the printer software. You must use the HP installer to install the printer on a network properly.

To install the printer software
1. Print a network configuration page. You may need the information included in this report if the installer cannot detect the printer. See Printing a network configuration page.
2. Insert the HP Photosmart printer software CD into the computer's CD-ROM drive.
3. Click Next and follow the instructions provided by the Installer to check and prepare the system, and install drivers, plug-ins, and software. This takes several minutes.
4. At the Connection Type screen, select Through the network, then click Next. The Searching screen appears as the Setup program searches for the printer on the network.

If the Printer Found screen appears, do this:
   a. Verify that the printer description is correct. (Use the configuration page to verify the printer name and hardware address. See Printing a network configuration page.)
   b. If the printer description is correct, select Yes, install this printer, then click Next. If more than one printer is found on the network, select HP Photosmart 8700 series as the device to configure and install, then click Next. If you have more than one HP Photosmart 8700 series printer on your network, use the Hardware Address (MAC) item listed in the network configuration page to identify the specific HP Photosmart 8700 series printer you want to install.

If the Check Cable Connection screen appears, do this:
   a. Follow the onscreen instructions, then select Specify a printer by address, then click Next.
   b. On the Specify Printer screen, enter the Hardware Address (MAC) number listed in the network configuration page in the Hardware Address (MAC) box.
      Example: 02bad065cb97
      MAC stands for Media Access Control, a hardware address that identifies the printer on the network.
   c. Enter the IP Address listed in the network configuration page in the IP Address box, then click Next.
      Example: 169.254.203.151
   d. When the Printer Found screen appears, select Yes, install this printer, then click Next.
   e. In the Confirm Settings screen, click Next.
   f. Follow the onscreen instructions.
5. When prompted, click Finish to exit the installation.
Installing the printer software on a Macintosh

Note Set up the printer as indicated in the setup instructions that came in the box.

Installation time can take 3–4 minutes depending on your operating system, the amount of available hard drive space, and the processor speed of the Macintosh. Make sure you have already connected the printer to the network with an ethernet cable before you begin the installation. If you have already installed this printer on a USB connection, you do not have to follow these instructions to do a network installation. Instead, see To change a USB connected printer to a network connection.

Note The printer software must be installed as described in this section on every networked computer from which you want to print to the HP Photosmart 8700 series printer. After the installation, printing is identical to printing to a printer connected by a USB cable.

To install the printer software

1. Insert the HP Photosmart printer software CD into the Macintosh CD-ROM drive.
2. Double-click the CD icon on the desktop.
3. Double-click the Installer icon. The Authenticate dialog appears.
4. Enter the Name and Password used to administer your Macintosh, then click OK.
5. Follow the onscreen instructions.
6. When the HP Photosmart Install window appears, choose Easy Install, then click Install.
7. In the Select Printer window, click the Network tab. The installer searches for any printers on the network.
   If the printer is found, do this:
   a. Select the HP Photosmart 8700 series printer in the Select Printer window, then click Utilities.
   b. Follow the onscreen instructions to register the printer.
   If the printer is not found, do this:
   a. Print a network configuration page and locate the IP Address entry listed on the page.
   b. Make sure the printer is connected by the correct type of CAT-5 ethernet cable to the network. See Connecting the printer to the network.
   c. Click Find, enter the IP Address, then click Save.
   d. Select the HP Photosmart 8700 series printer in the Select Printer window, then click Utilities.
   e. Follow the onscreen instructions to register the printer.

   Note Some browsers may not work with the online registration. If you encounter problems, either try another browser or skip this step.

8. Select the printer in the Print dialog box. If the printer does not appear in the list, select Edit Printer List to add the printer.
9. In the Printer List window, click Add.
10. Select Rendezvous from the drop-down list.
11. Select the printer from the list, then click Add.
That's it. You're done!

To change a USB connected printer to a network connection

1. Connect the printer to the network. See Connecting the printer to the network.
2. Print a network configuration page and locate the IP Address entry.
3. Open a web browser and enter the IP Address to access the embedded web server in the printer. For more information on the embedded web server, see Using the embedded web server.

4. Click the Networking tab.

5. Click mDNS in the Applications area on the left.

6. Enter a unique name (63 characters or less) in the mDNS Service Name box.

7. Click Apply.

8. Select the printer in the Print dialog box. If the printer does not appear in the list, select Edit Printer List to add the printer.

9. In the Printer List window, click Add.

10. Select Rendezvous from the drop-down list.

11. Select the printer from the list, then click Add.

### Using the embedded web server

The embedded web server in the printer provides a simple way to manage the networked printer. Using any web browser from either a Windows or Macintosh computer, you can communicate with the printer over the network to:

- Check printer status and estimated ink levels
- View network statistics
- Adjust the printer network configuration such as specifying a proxy server, setting a DNS name, or manually entering an IP address
- Restrict access to configuration pages
- Order supplies
- Go to the HP web site for support

#### To access the embedded web server home page

1. Print a network configuration page. See Printing a network configuration page.
2. Enter the printer IP address indicated on the network configuration page into the address box of your browser.

   Example IP address: 10.0.0.81

   The home page for the embedded web server appears.

For information about network terms and the embedded web server that is not covered in this guide, access the embedded web server help.

#### To access help for the embedded web server

1. Go to the embedded web server home page. See To access the embedded web server home page.
2. Click Help in the Other Links area of the home page.

### Printing a network configuration page

You can print a network configuration page from the printer without even being connected to a computer. The configuration page provides useful information regarding the printer IP address, network statistics, and other network settings. You can also display a summary of select network settings on the printer itself.

#### To print a detailed network configuration page

1. Press Menu on the printer.
2. Press ➕ until Network settings appears, then press ↗.
3. Press ➕ until Print network settings page appears, then press ↗.
Specifications

This section lists the minimum system requirements for installation of the HP Photosmart printer software, and provides selected printer specifications.

System requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Windows PC minimum</th>
<th>Macintosh minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Microsoft® Windows 98, 2000 Professional, ME, XP Home, and XP Professional</td>
<td>Mac® OS X 10.1.5 through 10.3</td>
</tr>
<tr>
<td>Processor</td>
<td>Intel® Pentium® II (or equivalent) or higher</td>
<td>G3 or greater</td>
</tr>
<tr>
<td>RAM</td>
<td>64 MB (256 MB recommended)</td>
<td>128 MB (256 MB recommended)</td>
</tr>
<tr>
<td>Free disk space</td>
<td>600 MB (2 GB recommended)</td>
<td>500 MB</td>
</tr>
<tr>
<td>Video display</td>
<td>800 x 600, 16-bit or higher</td>
<td>800 x 600, 16-bit or higher</td>
</tr>
<tr>
<td>CD-ROM drive</td>
<td>4x</td>
<td>4x</td>
</tr>
<tr>
<td>Connectivity</td>
<td><strong>USB</strong>: Microsoft Windows 98, 2000 Professional, ME, XP Home, and XP Professional</td>
<td><strong>USB</strong>: Front and back ports (Mac OS X 10.1.5 through 10.3)</td>
</tr>
<tr>
<td></td>
<td><strong>Ethernet</strong>: using the Ethernet port</td>
<td><strong>Ethernet</strong>: using the Ethernet port</td>
</tr>
<tr>
<td></td>
<td><strong>PictBridge</strong>: using front camera port</td>
<td><strong>PictBridge</strong>: using front camera port</td>
</tr>
<tr>
<td></td>
<td><strong>Bluetooth</strong>: using optional HP bt300 Bluetooth wireless printer adapter</td>
<td></td>
</tr>
<tr>
<td>Browser</td>
<td>Microsoft Internet Explorer 5.5 or later</td>
<td>—</td>
</tr>
</tbody>
</table>

Printer specifications

<table>
<thead>
<tr>
<th>Category</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connectivity</td>
<td><strong>USB</strong>: Microsoft Windows 98, 2000 Professional, ME, XP Home, and XP Professional; Mac OS X 10.1.5 through 10.3</td>
</tr>
<tr>
<td></td>
<td><strong>Ethernet</strong></td>
</tr>
<tr>
<td>Dimensions</td>
<td><strong>Weight</strong>: 11.8 kg (26 lbs)</td>
</tr>
<tr>
<td></td>
<td><strong>Height</strong>: 203 mm (8 inches)</td>
</tr>
</tbody>
</table>
### Specifications

<table>
<thead>
<tr>
<th>Category</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Width</strong>: 643 mm (25.3 inches)</td>
<td><strong>Depth</strong>: 398 mm (15.7 inches)</td>
</tr>
</tbody>
</table>

### Environmental specifications

- **Recommended during operation**: 0–45° C (32–113° F), 20–80% RH
- **Maximum during operation**: 5–40° C (41–104° F), 5–95% RH
- **Storage temperature range**: -30–65° C (22–149° F)

### Image file formats

- JPEG Baseline
- TIFF 24-bit RGB uncompressed interleaved
- TIFF 24-bit YCbCr uncompressed interleaved
- TIFF 24-bit RGB packbits interleaved
- TIFF 8-bit gray uncompressed/packbits
- TIFF 8-bit palette color uncompressed/packbits
- TIFF 1-bit uncompressed/packbits/1D Huffman

### Media specifications

- **Recommended maximum length**: 483 mm (19 inches)
- **Recommended maximum width**: 330 mm (13 inches)
- **Recommended maximum thickness**: 292 µm (11.5 mil)
- **Recommended plain paper media weight**: 60 to 90 g/m² (16 to 24 lb.)
- **Recommended maximum photo media weight**: 280 g/m²

### Media sizes

- **Supported sizes when printing from a computer**
  - 76 x 127 mm to 330 x 483 mm (3 x 5 inches to 13 x 19 inches)

- **Supported sizes when printing from the control panel**
  - Metric: 10 x 15 cm (with or without tab), 13 x 18 cm, A6, A3, A4, L, 2L
  - Imperial: 3.5 x 5 inches, 4 x 6 inches (with or without tab), 4 x 12 inches, 5 x 7 inches, 8 x 10 inches, 8.5 x 11 inches, 11 x 14 inches, 13 x 19 inches
  - Other: Hagaki

### Media types

- Paper (photo, plain, and inkjet)
- Envelopes
- Transparencies
- Labels
- Cards (index, greeting, Hagaki, A6, L-size)
- Iron-on transfers

### Memory cards

- CompactFlash Type I and II
- Microdrive
- MultiMediaCard
<table>
<thead>
<tr>
<th>Category</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure Digital Memory Sticks</td>
<td>xD-Picture Card</td>
</tr>
<tr>
<td>Memory card-supported file formats</td>
<td>Printing: See Image file formats earlier in table.</td>
</tr>
<tr>
<td></td>
<td>Saving: All file formats</td>
</tr>
<tr>
<td>Paper trays</td>
<td>Main tray</td>
</tr>
<tr>
<td></td>
<td>76 x 127 mm to 330 x 483 mm (3 x 5 inches to 13 x 19 inches)</td>
</tr>
<tr>
<td></td>
<td>Front feed slot</td>
</tr>
<tr>
<td></td>
<td>10 x 15 cm (4 x 6 inches) to 330 x 483 mm (13 x 19 inches)</td>
</tr>
<tr>
<td></td>
<td>Rear feed slot</td>
</tr>
<tr>
<td></td>
<td>76 x 127 mm to 330 x 483 mm (3 x 5 inches to 13 x 19 inches)</td>
</tr>
<tr>
<td></td>
<td>Out tray</td>
</tr>
<tr>
<td></td>
<td>All supported sizes</td>
</tr>
<tr>
<td>Paper tray capacity</td>
<td>Main tray</td>
</tr>
<tr>
<td></td>
<td>100 sheets of plain paper</td>
</tr>
<tr>
<td></td>
<td>14 envelopes</td>
</tr>
<tr>
<td></td>
<td>20–40 cards (depending on thickness)</td>
</tr>
<tr>
<td></td>
<td>20 sheets of banner paper</td>
</tr>
<tr>
<td></td>
<td>30 sheets of labels</td>
</tr>
<tr>
<td></td>
<td>25 photo paper, transparencies, or iron-on transfers</td>
</tr>
<tr>
<td></td>
<td>Front feed slot</td>
</tr>
<tr>
<td></td>
<td>10 sheets of photo paper</td>
</tr>
<tr>
<td></td>
<td>Rear feed slot</td>
</tr>
<tr>
<td></td>
<td>1 sheet of any media up to 292 µm (11.5 mil) thick</td>
</tr>
<tr>
<td></td>
<td>Out tray</td>
</tr>
<tr>
<td></td>
<td>50 sheets of plain paper</td>
</tr>
<tr>
<td></td>
<td>20 sheets of photo paper, banner paper, or transparencies</td>
</tr>
<tr>
<td></td>
<td>10 cards or envelopes</td>
</tr>
<tr>
<td></td>
<td>25 sheets of labels or iron-on transfers</td>
</tr>
<tr>
<td>Power consumption</td>
<td>Printing: 29 W</td>
</tr>
<tr>
<td></td>
<td>Idle: 6 W</td>
</tr>
<tr>
<td></td>
<td>Off: 5 W</td>
</tr>
<tr>
<td>Power supply model number</td>
<td>0950-4476, 0957-2105; 100-240 Vac (+/-10%) 50/60 Hz (+/- 3 Hz)</td>
</tr>
<tr>
<td>Category</td>
<td>Specifications</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Print cartridges** | HP Gray Photo  
|                   | HP Color Photo  
|                   | HP Tri-color  
|                   | HP Black  
|                   | HP Blue Photo  
| **Note**          | The cartridge numbers you can use with this printer appear on the back cover of the printed *HP Photosmart 8700 series User’s Guide*. If you have already used the printer several times, you can find the cartridge numbers in the HP Photosmart 8700 series Toolbox. For more information on accessing the Toolbox, see [Inserting print cartridges](#). |
| **USB support**   | Microsoft Windows 98, 2000 Professional, ME, XP Home, and XP Professional  
|                   | Mac OS X 10.1.5 through 10.3  
|                   | HP recommends that the USB cable be less than 3 meters (10 feet) in length |
| **Network support** | Microsoft Windows 98, 2000 Professional, ME, XP Home, and XP Professional  
|                   | Mac OS X 10.1.5 through 10.3 |
A. Extent of limited warranty
1. Hewlett-Packard (HP) warrants to the end-user customer that the HP products specified above will be free from defects in materials and workmanship for the duration specified above, which duration begins on the date of purchase by the customer.
2. For software products, HP's limited warranty applies only to a failure to execute programming instructions. HP does not warrant that the operation of any product will be uninterrupted or error free.
3. HP's limited warranty covers only those defects that arise as a result of normal use of the product, and does not cover any other problems, including those that arise as a result of:
   a. Improper maintenance or modification;
   b. Software, media, parts, or supplies not provided or supported by HP;
   c. Operation outside the product's specifications;
   d. Unauthorized modification or misuse.
4. For HP printer products, the use of a non-HP ink cartridge or a refilled ink cartridge does not affect either the warranty to the customer or any HP support contract with the customer. However, if printer failure or damage is attributable to the use of a non-HP or refilled ink cartridge, HP will charge its standard time and materials charges to service the printer for the particular failure or damage.
5. If HP receives, during the applicable warranty period, notice of a defect in any product which is covered by HP's warranty, HP shall either repair or replace the product, at HP's option.
6. If HP is unable to repair or replace, as applicable, a defective product which is covered by HP's warranty, HP shall, within a reasonable time after being notified of the defect, refund the purchase price for the product.
7. HP shall have no obligation to repair, replace, or refund until the customer returns the defective product to HP.
8. Any replacement product may be either new or like-new, provided that it has functionality at least equal to that of the product being replaced.
9. HP products may contain remanufactured parts, components, or materials equivalent to new in performance.
10. HP's Limited Warranty Statement is valid in any country where the covered HP product is distributed by HP. Contracts for additional warranty services, such as on-site service, may be available from any authorized HP service facility in countries where the product is distributed by HP or by an authorized importer.

B. Limitations of warranty
TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY SUPPLIERS MAKES ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

C. Limitations of liability
1. To the extent allowed by local law, the remedies provided in this Warranty Statement are the customer's sole and exclusive remedies.
2. TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN THIS WARRANTY STATEMENT, IN NO EVENT SHALL HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

D. Local law
1. This Warranty Statement gives the customer specific legal rights. The customer may also have other rights which vary from state to state in the United States, from province to province in Canada, and from country to country elsewhere in the world.
2. To the extent that this Warranty Statement is inconsistent with local law, this Warranty Statement shall be deemed modified to be consistent with such local law. Under such local law, certain disclaimers and limitations of this Warranty Statement may not apply to the customer. For example, some states in the United States, as well as some governments outside the United States (including provinces in Canada), may:
   a. Prohibit the disclaimers and limitations in this Warranty Statement from limiting the statutory rights of a consumer (e.g., the United Kingdom);
   b. Otherwise restrict the ability of a manufacturer to enforce such disclaimers or limitations; or
   c. Grant the customer additional warranty rights, specify the duration of implied warranties which the manufacturer cannot disclaim, or allow limitations on the duration of implied warranties.
3. THE TERMS IN THIS WARRANTY STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT, OR MODIFY, AND ARE IN ADDITION TO, THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THE HP PRODUCTS TO SUCH CUSTOMERS.
Index

A
aligning print cartridges 14, 43
alignment page 43

B
black-and-white photos 13
Bluetooth
connecting to printer 29
wireless printer adapter 30
borderless prints
printing from a computer 27
printing from the control panel 37
buttons 6

C
cameras
Bluetooth 39
connecting to printer 29
PictBridge 39
port 4
printing from 39
care and maintenance 41
cartridges. See print cartridges
cleaning
print cartridges 41
printer 41
color management
application-based 22
calibrating a monitor 22
ICC device profiles 22
installing ICC profiles 22
printer-based 19
CompactFlash 30
computer
printing from 3, 17
system requirements 71
control panel 6
creative projects
HP Creative Scrapbook Assistant 26
large-format templates 25
scrapbooking 25
customer care. See HP Customer Care

digital cameras. See cameras
documentation, printer 3

documentation, printer 3

e
error messages 54
ethernet 65

F
file formats, supported 31, 72
front feed slot 12

H
help. See troubleshooting
ehelp, onscreen 3, 4
HP Creative Scrapbook Assistant 26
HP Customer Care 61
HP Image Zone 26
HP Software Update 43

I
ink cartridges. See print cartridges
ink level, checking 14, 42
ink-backup printing mode 14
inserting
memory cards 31
print cartridges 14

J
JPEG file format 31

L
large-format templates 25
layout
and photo size 33
large-format layout templates 25
lights 7
loading paper
in front feed slot 12
in Main tray 12
in rear feed slot 12

M
Main tray 12
memory cards
errors 57
inserting 31
printing from 30
removing 33
supported types 30
Memory Sticks 30
menu, printer 7
Microdrive 30
MultiMediaCard 30

N
network configuration page 70
networking
connecting printer to network 66
embedded web server 70
ethernet 65
network configuration page 70
software installation (Mac OS) 69
software installation (Windows) 67

O
onscreen Help 3

P
paper
buying and choosing 9
loading 11
maintaining 9, 44
specialty 10
specifications 71
storing 44
trays 4
paper jams 51
photos
improving quality 37
print cartridges, choosing 13
printing 30
Regulatory notices

Hewlett-Packard Company

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:

- This device may not cause harmful interference, and
- This device must accept any interference received, including interference that may cause undesired operation.

Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this equipment not expressly approved by Hewlett-Packard Company may cause harmful interference, and void your authority to operate this equipment. Use of a shielded data cable is required to comply with the Class B limits of Part 15 of the FCC Rules.

For further information, contact: Hewlett-Packard Company, Manager of Corporate Product Regulations, 3000 Hanover Street, Palo Alto, CA 94304, (650) 857-1501.

Note

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, can cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

LED indicator statement

The display LEDs meet the requirements of EN 60825-1.